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MENGENAL PROGRAM APLIKASI GRAFIS 
 
Tujuan pembelajaran  
Setelah mempelajari materi ini, diharapkan anda dapat : 
1. Mengidentifikasi perbedaan grafis berbasis vector dan grafis 

bitmap 
2. mengidentifikasi program aplikasi berbasis vector dan 

program aplikasi berbasis bitmap. 
 
KATA KUNCI 
 
Grafis komputer, vector, bitmap, Raster, resolusi, 
Pengoalah grafis. 

 
Adanya kemajuan teknologi komputer yang didukung oleh 

perkembangan perangkat lunak atau software makin 
memudahkan kita melakukan aktifitas dalam pekerjaan kita. 
Contohnya   dalam pembuatan brosur (brochure), selebaran 
(leaflet), ataupun pamplet. Tahukah anda dengan program 
aplikasi apa brosur dam selebaran dibuat? Ada banyak 
kemungkinan jawaban, bisa menggunakan program pengolah 
kata biasa ataupun menggunakan program aplikasi khusus 
grafis. Pertanyaan yang lebih cepat adalah: Software apakah 
yang cocok untuk membuat brosur dan selebaran itu? 
Mengingat brosur dan selebaran yang menarik biasanya 
menyertakan gambar dan huruf-huruf yang cukup attraktif, 
software yang cocok digunakan tentu saja software aplikasi 
grafis komputer atau kita sebut software aplikasi grafis. 

Software aplikasi grafis apakah yang cukup praktis dan 
mudah kita gunakan? Intuk menentukan software aplikasi grafis 
yang tepat, kita perlu menentukan dulu tipe grafik (graphic) yang 
akan kita buat. Apa sajakah tipe-tipe grafik bisa kita buat dan 
apa kelebihan serta kekurangan?  
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A. Tipe-Tipe Grafik Komputer 
 

Sebelum membahas lebih lanjut, anda perlu memahami dulu 
bahwa istilah “grafik” di sini berbeda dengan istilah “grafik” pada 
frase grafik xy, grafik batang, ataupun grafik kelulusan siswa. 
Grafik dalam hal ini merupakan kata lain dari citra visual (image), 
atau secara umum kita sebut sebagai “gambar” 

Dalam dunia komputer terutama di bidang desain dam 
grafika di kenal dua type grafik, yaitu grafik vector dan grafik 
bitmap. 
 
1. Grafik Bertipe Vektor 
 

Grafik dengan tipe (atau format) vector merupakan gambar 
yang dibentuk obyek berupa garis dan kurva berdasarkan rumus 
matematika. Vector menampilkan sebuah gambar berdasarkan 
perhitungan koordinat geometris gambar tersebut. Obyek vector 
banyak digunakan dalam pengelolaan teks dan logo. 

Kualitas hasil tampilan vector tidak tergantung pada 
resolusi gambar (istilahnya: resolution independent), yang 
artinya gambar vector bisa diubah-ubah ke berbagai ukuran 
dan juga dapat dicetak pada tingkat resolusi gambar 
sebesar apapun tanpa kehilangan kehalusan dan 
ketajamannya. Citra atau grafik vector merupakan pilihan 
terbaik ketika harus menampilkan gambar-gambar yang harus 
dipertahankan ketajamannya serta kehalusannya ketika 
ukurannya berubah-ubah (diperbesar ataupun diperkecil). 

Grafik vector juga hanya memerlukan ruang penyimpanan 
yang relative kecil (hemat) sehingga media penyimpanan di 
komputer anda tidak cepat penuh. Untuk gambar-gambar 
sederhana seperti bangun geometri yang tidak terlalu rumit 
pewarnaannya, anda disarankan untuk menggunakan tipe 
vector. 
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Dalam bentuk file, citra vector biasannya memiliki format 
*.eps (encapsulated postscrip),*.wmf (windows metafile) atau 
sesuai dengan software aplikasi grafis pembetukannya. 
 
2. Grafik Bertipe Bitmap 

 
Grafik (citra) bitmap juga dikenal dengan istilah raster. Citra 

bitmap menggunakan titik-titik berwarna yang disebut pixel (pic-
ture element). Pixel-pixel tersebut ditempatkan pada lokasi-
lokasi tertentu dengan nilai-nilai warna tersendiri dan secara 
keseluruhan akan membentuk tampilan. 

Tampilan bitmap mampu menunjukan kehalusan gradasi dan 
warna dari sebuah gambar. Oleh karena itu format bitmap paling 
tepat digunakan untuk gambar-gambar dengan gradasi warna 
yang rumit seperti foto dan lukisan digital. Namun, format bitmap 
mempunyai kelemahan dimana setiap tampilan sangat 
tergantung pada resolusi gambar (istilahnya: resolution 
dependent), artinya setiap gambar mempunyai jumlah pixel yang 
pasti (tetap). Akibatnya gambar bisa kehilangan detail dan juga 
terlihat “kotak-kotak”(jagged) jika ukurannya diperbesar atau jika 
resolusinya diperkecil dari resolusi aslinya. Citra dengan format 
bitmap ini memerlukan ruang pemyimpanan data yang relatif 
besar, sebanding dengan ukuran dan resolusi yang dimilikinya. 

Dalam bentuk file citra bitmap biasannya memiliki format 
*.bmp, *. Jpg, *jpeg, *. Tif, *. Tiff, ataupun *. Png. Gambar yang 
dihasilkan oleh kamera digital ataupun scanner Anda akan 
ditransfer ke komputer dalam bentuk citra bitmap. 
 
3. Perbandingan antara Grafik vector dan grafik bitmap 
 

Mana yang harus dipilih ketika kita akan membuat suatu 
grafis, tipe vector ataukah tipe bitmap? Untuk membantu 
menentukan pilihan, pelajari perbandingan keduannya berikut 
ini: 
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TABEL 1.1 PERBANDINGAN GRAFIK VEKTOR DAN GRAFIK 
BITMAP 
 

Grafik Bitmap Grafik Vektor 
Terdiri atas kumpulan pixel 
dengan warna tertentu 

Terdiri atas kurva and garis 
berdasarkan rumus matematis 

Resolution dependent  Resolusi independent 
Memerlukan ruang penyimpan 
yang relative lebih besar  

Memerlukan ruang penyimpanan 
yang relatif  lebih kecil 

Cocok untuk gambar yang detail 
dengan gradasi warna yang rumit 

Cocok untuk gambar dengan 
warna sederhana (tidak rumit) 

           
 
4. Atribut-Atribut pada Citra Grafis Komputer 
 

 Yang dimaksud atribut pada Citra grafis komputer meliputi 
warna, resolusi, dan tipe file. 
 
a. Warna grafik 
 suatu citra dapat memiliki warna lengkap (color) atau hanya 

memiliki warna hitam putih saja (BW=black-white atau 
grayscale). Ada beberapa mode pewarnaan citra, di 
antarannya adalah mode RGB (red, green, blue) dan mode 
CMYK (cyan, magenta, yellow, black). Mode RGB biasanya 
bagus digunakan untuk visualisasi di monitor komputer, 
sedangkan mode CMYK biasanya digunakan untuk 
percetakan dengan separasi warna. 

 
b. Resolusi Grafik 
 Resolusi merupakan jumlah pixel yang dimiliki suatu citra. 

Pixel merupakan ciri suatu citra bitmap sehingga resolusi 
dapat menjelaskan kualitas suatu citra bitmap. Jika 
merupakan atribut asli (belum diproses). Makin tinggi 
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resolusi suatu citra, makin tinggi kualitasnya, yang berarti 
makin luas gambarnya. 

 Resolusi dapat dinyatakan dalam bentuk jumlah pixel seperti 
misalnya 800 x 600 atau 1024 x 768. resolusi dapat juga 
dinyatakan dalam satuan dpi (dot per inch) atau ppi (pixel per 
inchi) ataupun pixel per inchi. 

 Oleh karena suatu citra vector bersifat resolution 
independent, atribut resolusi tidak dimiliki oleh citra ini, 
Namun, jika dilakukan konversi suatu citra vector ke citra 
bitmap (istilahnya: rasterize). Citra vector dapat di beri atribut 
resolusi tertentu. 

 
B. program Aplikasi Pengolah Grafik 

 
Anda sudah mengenal tipe-tipe citra grafik dan beberapa 

karakteristiknya. Sekarang anda akan mempelajari beberapa 
program (software) aplikasi grafis yang dapat di gunakan untuk 
membuatnya. Ada banyak sekali program aplikasi grafis yang 
beredar dipasaran, sebagian diantarannya: Wundows paint, 
macromedia freehand, Autocad, Swif 3D, Maya 3D, Adobe 
photoshop, Coreldraw, Corel photopaint, dan Adobe illustrator. 
Program-program aplikasi grafis tersebut dapat dikelompokkan 
menjadi dua golongan besar, yaitu program aplikasi grafis 
berbasis bitmap dan program aplikasi grafis berbasis vector. 

Di antara program-program aplikasi yan disebutkan di atas, 
yang termasuk program aplikasi grafis bitmap adalah: Paint, 
Adobe photoshop, chorel photopaint, sedangkan sisanya adalah 
program aplikasi berbasis vector. 

Selain dikelompokkan berdasarkan tipe citra (bitmap ataukah 
vector) yang dihasilkannya, program-program aplikasi tersebut 
dapat juga dikelompokkan berdasarkan caranya mengolah citra, 
yaitu dikelompokkan menjadi program aplikasi grafis dua 
dimensi (2D) dan program aplikasi grafis tiga dimensi 3D. 
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Apakah foto yang ditransfer dari kamera digital ke komputer 
anda merupakan citra 2D ataukah 3D? jika anda dapat melihat 
gambar keseluruhan anda di layar komputer, berarti gambar 
tersebut merupakn citra 3D. Kenyataannya, gambar atau foto 
anda di Komputer merupakan citra 2D.  
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Program Grafis Berbasis Vektor 
CorelDraw 12 

 
Pendahuluan 
 

Program grafis ini memang begitu besar pengaruhnya terhadap 
perkembangan desain komputer pada umumnya. Banyak pengguna 
yang menyatakan bahwa perkembangan CorelDraw telah begitu pesat 
mempengaruhi perkembangan seni grafis digital yang semakin 
mempesona. perkembangan software desain grafis telah mempengaruhi 
pula pandangan tentang seni digital yang baru ini. 

Pemanfaatan CorelDraw telah merambah kesemua bidang tidak 
hanya desain grafis semata, sehingga pemakaian CorelDraw semakin 
banyak diminati karena keluwesannya serta kemudahannya dalam hal 
pemakaian tool yang disediakan untuk memenuhi segala kebutuhan 
publikasi. 

Beberapa fasilitas telah begitu berkembang seperti sebuah evolusi 
menuju kesempurnaan dan kemudahan. Telah menjadi ciri software 
dimana perkembangan perangkat serta tool yang menyertainya selalu 
diperbarui dan ditampilkan dengan wajah baru akan tetapi tidak 
meninggalkan esensi dasar dari perintah perintah dibalik tool tersebut. 
 
Bitmap dan Vektor 

CorelDraw adalah program grafis dengan basis vektor atau garis. 
CorelDraw versi 12 dapat pula mengolah gambar dengan basis bitmap 
dengan hasil yang tidak kalah dengan pengolah bitmap yang 
sesungguhnya. bitmap tersusun dari titik - titik kecil dengan sebutan 
pixel. Dimana unsur terkecil ini akan membentuk suatu kesan yang 
ditangkap oleh mata sebagai sebuah gambar. Apabila gambar tersebut 
dibesarkan hingga melawati batas maksimalnya maka gambar tersebut 
akan terlihat unsur dasarnya yaitu kotak - kotak warna. 

CorelDraw menggunakan dasar vektor dalam mengolah image, 
dimana unsur dasarnya adalah garis. Keuntungan dari vektor ini adalah 
gambar akan mempunyai ukuran yang relatif kecil, kemudian jika 
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gambar dibesarkan maka tidak gambar akan tetap terlihat solid atau 
utuh.. Sebagai pengolah image berbasis vektor CorelDraw sangat 
powerfull dalam pengolahan image ilustrasi.Akan tetapi dengan 
perkembangan CorelDraw yang semakin pesat, pengolahan obyek 
bitmap dapat juga dengan mudah dimanipulasi dalam aplikasi 

CorelDraw, bahkan filter - filter efek khusus pengolah bitmap 
telah disertakan dalam fungsi tersendiri. 

Banyak sekali keuntungannya jika kedua jenis gambar ini dapat 
diolah dalam satu aplikasi, sebab manipulasi obyek dengan lain 
aplikasi akan memperpanjang langkah dalam mewujudkan kmposisi 
image yang diinginkan. Anda harus mempunyai kemampuan untuk 
menganalisa, apakah perlu bantuan aplikasi lain atau cukup dengan 
menempa anda untuk secara cepat memutuskan apakah butuh aplikasi 
lain atau cukup dengan CorelDraw saja. 
 
1.1 Produktivitas Dan Unjuk Kerja 

CorelDraw memungkinkan kita untuk bekerja lebih efisien dengan 
adanya penambahan kemampuan produktivitas dan unjuk kerja pada 
CorelDraw, seperti penggunaan tombol Alt untuk memilih obyek - 
obyek yang tersembunyi dalam tumpukan atau grup gambar. 

Kita dapat mengelola obyek - obyek dalam ilustrasi lebih mudah 
dengan menggunakan kemampuan kemampuan khusus pada 
CorelDraw seperti berikut : 

 
Guideline sebagai obyek 
Dengan guideline kita dapat bekerja dengan grafik lebih tepat. 
Guideline dapat dipilih lebih dari satu, diputar, dihapus, atau 
ditempatkan pada lokasi yang tepat dengan menggunakan fasilitas 
nudge seperti obyek obyek yang lain pada CorelDraw. 
 
 
Smart Duplicate 
Patern obyek dapat diulang-ulangdengan menggunakan fasilitas Smart 
Duplicate. Setiapkali obyek duplikat dibuat dan dipindahkan keposisi 
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baru, perintah Duplicate akan menggunakan posisi baru yang telah 
ditentukan ke lokasi duplikat berikutnya. 
 
Node Editing 
Editing Node dasar dengan menggunakan Pick Tool dibuat lebih 
mudah. Dengan 
menggunakan tool - tool drawing dasar, kita dapat memanipulasi posisi 
dan bentuk obyek. Akses terhadap Shape Tool telah dipermudah, yaitu 
hanya dengan perintah Double Click pada obyek yang dimaksud. 
 
Keyboard Accelerator 
Kemampuan untuk melakukan tugas - tugas dengan menggunakan 
keyboard dibuat lebih mudah dengan memasukkantombol akselerator 
baru. Gunakan tombol TAB dan ALT untuk mempermudah manipulasi 
obyek. 
 
Display Bitmap 
Pada saat bekerja dengan obyek, kita dapat dengan cepat mengubah 
tampilan dari outline ke full bitmap yang diwakili tombol TAB. 
Dengan adanya perpindahan antar view display memungkinkan kita 
untuk menampilkan dan menempatkan obyek dengan tepat. Kita dapat 
mengaktifkan pilihan Setting Use Offscreen Image yang ada pada 
kotak dialog Options untuk menampilkan image dengan otomatis. Pada 
saat pilihan setting tersebut dipilih, CorelDraw menonaktifkan refresh 
image. 
 
Kontrol Interaktif 
Penambahan pada kontrol - kontrol on-screen untuk beberapa tool 
interactif vektor akan mempercepat dan mempermudah akses 
pengaturan setting fasilitas obyek. 
 
1.2 Tool Tool Interaktif 

CorelDraw menyediakan beberapa tool interactif yang 
memudahkan kita dalam membuat efek - efek khusus dengan cepat dan 
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mudah. Tool Drop Shadow interaktif akan membuat bitmap Drop 
Shadow ( efek bayangan) pada obyek. sedangkan untuk membuat 
bentuk - bentuk baru kita dapat menggunakan tool Push and Pull, 
Zipper ataupun Twister. Tool Envelope interaktif dan tool Extrude 
interaktif digunakan untuk menambahkan efek – efek envelope dan 
extrude pada obyek gambar dengan cepatdan mudah. Kita dapat 
melakukan transformasi obyek - obyekgambar secara bebas dengan 
menggunakan tool Free Transform. Dapat juga mengatur dan 
mencampur warna obyek secara interaktif dengan menggunakan Color 
Palette bersama tombol Ctrl dan mouse. 
 
Interactif Drop Shadow 
Tool ini memungkinkan kita menerapkan bitmapefek bayangan 
kedalam obyek yang sedang dibuat. dengan adanya tool interactif ini 
kita dapat mengatur drop shadow secara langsung, seperti mangatur 
arah, tingkat transparansi dan warna drop shadow.  
 
Tool Distorsion 
Kita dapat mendistorsi obyek dengan menggunakan tool Distorsion. 
kita dapat menerapkan efek push and pull untuk men-drag node-node 
kearah dalam atau keluar dari beberapa titik pada drawing page. Tool 
Zipper digunakan untuk mengubah garis ke kurva dan membuat efek 
zig-zag pada suatu obyek. Tool Twister digunakan untuk memutar-
mutar node dengan arah searah jarum jam atau berlawanan jarum jam 
mengitari titik tengah. 
 
Color Mixing 
Color mixing adalah fasilitas untuk melakukan proses pencampuran 
warna secara interaktif. kita pahami bahwa warna merupakan unsur 
penting dalam sebuah desain. Oleh karena itu CorelDraw memberikan 
fasilitas khusus untuk melakukan proses pancampuran warna secara 
langsung menggunakan palet warna sehingga menghasilkan warna 
sesuai dengan keinginan desainer. 
Extrude 
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Fasilitas Extrude adalah fasilitas khusus pada CorelDraw yang 
berfungsi untuk melakukan transformasi dari satu obyek ke obyek lain. 
Misalnya ingin melakukan transformasi atau perubahan obyek dari 
bintang ke lingkaran, maka langkah yang dilakukan sangat mudah dan 
cepat. 
 
Free Transform 
Dengan menggunakan tool ini kita dapat memutar, skew, scale dan 
merefleksi obyek pada suatu titik didalam drawing page. Cara kerja 
tool ini mendekatkan kita memperoleh titik tengah obyek terpilih 
dengan bebas. kita juga dapat mengintrol lebih jauh mengenai posisi 
titik tengah sebuah obyek. 
 
Fill Tilling 
Fasilitas Patern dan Texture Fill ditambah dengan tool interaktif Patern 
Tilling yang baru. Pada interface layar kita dapat langsung mengatur 
ukuran, posisi, memutar dan skew patern atau texture yang berisi 
obyek. Pilihan Scale With Objects memungkinkan kita melakukan 
transformasi Fill Pattern atau texture dengan obyek. 
 
MEMULAI COREL DRAW 
Untuk mulai bekerja mneggunakan program CorelDraw 11, terlebih 
dulu memanggil program tersebut. Untuk memanggil programnya 
adalah sebagai berikut : 
Klik menu Start � Program � Program Grafis � Corel Draw � 
Colerdraw 12 
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Maka program CorelDraw akan muncul seperti berikut : 

 
 

Gambar 1. Layar CorelDraw 11. 
Keterangan : 

a. Title Bar  g. Color Pallete 
b. Menu Bar  h. Tool Box 
c. Standard Tool Bar  i. Vertical Scrool Bar 
d. Property Bar  j. Vertical Ruler 
e. Horizontal Ruler  k. Horizontal Scrool Bar 
f. Printable area  l. Status Bar 

 
 
LAYAR COREL DRAW 

- Title Bar 
Memberi informasi tentang nama file dan aplikasi yang sedang dibuka. 
Pada ujung pojok kanan atas terdapat tombol Maximize Button untuk 
membuat tampilan CoreDraw satu layar penuh, Minimize button untuk 
meletakkan program pada Taskbar menu, sedangkan Close button 
untuk mengakhiri program. 
 
- Menu Bar 

a 
b 
c 
d 
e 

f 

g 

h 

i 

j 

k 
l 
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Menu Bar adalah barisan menu yang terdiri dari File, Edit, Layout, 
Type, Element, Utilities, View, Window dan Help. Semua perintah-
perintah terdapat pada menu menu tersebut. 
 
 
- Standard Tool Bar 
Perintah - perintah yang sering digunakan dapat juga diakses melalui 
Standard Tool Bar. Pada Standard Tool Bar terdapat icon - icon 
perintah yang sering kita gunakan, misalnya untuk membuat file baru, 
membuka file, menyimpan, mencetakdan sebagainya. Hanya dengan 
klik sekali pada icon yang dimaksud maka perintah akan langsung 
dijalankan oleh CorelDraw. 
 
- Property Bar 
Property Bar merupakan baris perintah yang unik, karena tampilannya 
akan selalu berubah dan perintah-perintah yang ada didalamnya akan 
menyesuaikan dengan icon yang sedang aktif pada tool Box. Misalnya 
tool Box sedang aktif pada Zoom Tool, maka akan memunculkan 
property dari Zoom tool, demikian juga dengan tooltool yang lain. 
Disini kita akan dapat lebih cepat dalam mengakses perintah-perintah 
yang berhubungan dengan tool yang sedang aktif. 
 
- Horizontal Ruler 
berfungsi untuk membantu kita dalam membuat desain dengan ukuran 
yang tepat. karena terdapat mistar horizontal dengan satuan ukuran 
yang dapat kita ubah sewaktu-waktu. 
 
- Printable Area 
merupakan area dimana desain kita diletakkan untuk dicetak. Untuk 
mendesain kita boleh di luar printable area, namun ketika akan dicetak 
maka harus dimasukkan ke printable area tersebut. 
 
- Color Palette 
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Warna merupakan unsur penting dalam sebuah desain grafis. Corel 
Draw memberikan berbagai kemudahan untuk mengakses dan memilih 
berbagai model warna. Kita dapat mengakses tool-tool warna melalui 
on-screen color palette, Color dialog box, maupun Color Roll-upuntuk 
memilih warna isi, outline, kertas dan lain-lain. Namun langkah yang 
tercepat untuk mengakses warna adalah melalui On-screen color palette 
yan gtesedia di sebelah kanan window. 
 
- Tool Box 
merupakan barisan icon yang menyimpan berbagai macam perintah 
untuk pembuatan obyek dasar, editing obyek, efek-efek interaktif dan 
lain lain. 
 
- Vertical Scrool Bar 
Penggulung halaman secara vertical. Anda dapat menggeser scrool bar 
ke atas dan kebawah untuk memperluas lembar kerja atau untuk 
melihat bagian tertentu dari gambar yang belum terlihat. 
 
- Vertical Ruler 
Vertical ruler berfungsi untuk membuat garis bantu vertical.  
 
- Horizontal Scrool Bar 
penggulung halaman secara horisontal. Anda dapat menggeser 
horizontal scrool bar untuk melihat bagian kanan atau bagian kiri 
laembar kerja yang belum terlihat. 
 
- Status Bar 
Memberikan informasi tentang operasi yang sedang dilakukan, 
koordinat posisi mouse berada dan juga informasi tentang warna pada 
obyek yang sedang diaktifkan, baik warna fill maupun outline. Yang 
perlu diperhatikan pada setiap bagian window Corel Draw adalah, kita 
dapat mengakses suatu perintah melalui berbagai cara yang kita sukai. 
Misalnya untuk membuat file baru, dapat memalui menu bar, tool bar, 
maupun menggunakan perintah Short Cut. 
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TOOL BOX 
 

Tool Box merupakan sarana utama pada Corel Draw. Tool Box 
menyimpan erbagai perintah perintah untuk membuat obyek dasar, 
editing obyek, memberikan fek-efek interaktif dan lain-lain. 
 
 
        
        
        
        
 
          
         
        
        
 
 
 
 
 
 
 
 
 

Gambar 2. Tool Box. 
 

Sebelum memulai desain terlebih dulu disiapkan format halaman 
yang digunakan, jenis kertasyang dipakai, ukuran, orientasi kertas dan 
lain-lain. Berikut ini adalah langkah-angkah untuk pengaturan halaman 
: 
1. Klik menu Layout  Page Setup. Terdapat dua jenis layout yaitu 

Normal Paper dan Label. 
 

Gambar 3. Page Setup 
 

2.  Tentukan orientasi 
kertas dengan memilih 
Portrait atu landscape 
3.  Paper merupakan 
jenis kertas yang akan 
digunakan. 

Pick Tool 
Shape Tool 
 Zoom Tool 
 Bezier Tool 
 Rectangular Tool 
 
Eliptical Tool 
 
Polygon Tool 

Callout Tool 

Special Effect Tool 

EyeDropper Tool 
 
Outline Tool 
 
Fill Tool 
 
Interactive Fill Tool 
 

Text Tool 
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4.  Width adalah menentukan lebar kertas, Height menentukan tinggi 
kertas. Jika sudah ditentukan sesuai dengan kebutuhan lalu Klik 
OK. 

 
Catatan : Untuk mengatur halaman dapat juga melalui Property Bar, 
dengan cara mengaktifkan Pick Tool pada Tool Box. 
 
MENGGAMBAR BIDANG DAN TEKS 
 
Membuat Kotak persegi Panjang dan Kubus 
1.  Klik icon  Rectagular Tool   pada tool box.  Maka pointer  akan 

berubah  menjadi  
2.  Klik-tahan-geser menuju kanan bawah membentuk kotak. 
3.  Lepaskan mouse, maka akan membentuk sebuah persegi panjang. 
4. Tekan-tahan tombol Ctrl pada keyboard, Klik-tahan-geser menuju 

kanan bawah membentuk kotak. 
5.  Lepaskan mouse, maka akan membentuk sebuah obyek bukur 

sangkar. 
Contoh hasil : 

 
 

Tanpa menekan tombol Ctrl, 
menghasilkan persegi panjang 
 
 
Dengan menekan tombol Ctrl, 
menghasilkan bujur sangkar. 

 
 

Gambar 4. Obyek kotak 
 
Membuat Lingkaran dan Elipse 
1.  Klik icon Ellipse Tool  pada Tool box. Maka pointer akan 

berubah menjadi  
2.  Klik-tahan-geser menuju kanan bawah membentuk kotak. Lepaskan 

mouse, maka akan membentuk sebuah elips. 
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4. Tekan-tahan tombol Ctrl pada keyboard, Klik-tahan-geser menuju 
kanan bawah membentuk kotak. 

5.  Lepaskan mouse, maka akan membentuk sebuah obyek lingkaran. 
 

Contoh hasil : 
 

Tanpa menekan tombol Ctrl, 
menghasilkan elips 
 
Tanpa menekan tombol Ctrl, 
menghasilkan lingkaran 

 
Gambar 5. Obyek lingkaran 

 
Membuat Polygon, Spiral dan Graph Paper 
 
Klik panah bawah yang terdapat pada sudut kanan bawah icon Polygon 
Tool, maka akan muncul icon seperti berikut :  
1.  Klik icon Polygon  untuk membuat polygon. Lalu bawa ke 

halaman dan klik-tahan-geser menuju kanan bawah. maka akan 
menjadi obyek segilima. 

2.  Klik icon Spiral Tool  . Lalu bawa ke halaman dan klik-
tahangeser menuju kanan bawah. maka akan menjadi obyek spiral. 

3.  Klik icon Graph Paper Tool  . Lalu bawa ke halaman dan 
kliktahan-geser menuju kanan bawah. maka akan menjadi obyek 
tabel. 

 

 
 

Gambar 6. Obyek Polygon, Spiral dan Graph. 
 
Membuat Teks 
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1.  Klik icon Text Tool  , maka pointer akan berubah menjadi 
2. Klik di bagian bawah halaman, lalu ketik naskah “KOTA PALU ” 
 
 

Catatan : Setiap selesai membuat obyek, selalu klik icon Pick Tool  . hal ini untuk 
menghindari pembuatan obyek baru yang sama bentuknya. 
 
 
MENGEDIT OBYEK DASAR 
 
Menggeser Obyek 
1.  Aktifkan obyek elips, maka dibagian sisi obyek tedapat delapan 

kotak kecil yang disebut dengan node serta terdapat tanda silang 
pada bagian tengah elips. 

 

 
Gambar 7 . Node 

 
2.  Letakkan pointer pada tanda silang dibagian tengah obyek elips 

sehingga pointer berubah menjadi panah empat arah. 
3.  Klik-tahan-geser ke tempat lain, maka obyek elips tersebut akan 

bergeser. 
 
 
Memperbesar dan memperkecil ukuran obyek 
1.  Klik obyek lingkaran sehingga muncul node. 
2.  Letakkan pointer pada node di pojok kanan bawah sehingga 

berubah menjadi panah memojok. 
3.  Klik-tahan-geser ke arah kanan bawah, sehingga obyek lingkaran 

menjadi lebih besar. 
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Gambar 8. Membesarkan obyek 
 
4.  Klik obyek persegi panjang sehingga muncul node. 
5.  Letakkan pointer pada node di pojok kanan bawah sehingga 

berubah menjadi panah memojok. 
6.  Klik-tahan-geser ke arah kiri-atas, sehingga obyek persegi panjang 

menjadi lebih kecil. 
 
 
 
 
 
 
 
 

Gambar 9. Mengecilkan Obyek 
 
Catatan : 
Untuk memperbesar dan memperkecil dapat dilakukan pada setiap node. Jika menggunakan 
node pada setiap pojok, maka pembesaran dan pengecilan obyek secara proporsional. 
sedangkan pada node selain pojok akan menghasilkan perubahan obyek secara bebas. 
 
 
Rotasi Obyek 
1.  Aktifkan obyek segi lima sehingga muncul node. 
2.  klik sekali lagi pada obyek tersebut sehingga node akan berubah 

menjadi anak panah. 
3.  Letakkan pointer pada salah satu anak panah pada salah satu pojok, 

sehingga berubah menjadi pointer panah melingkar . 
4. Klik-tahan-putar searah jarum jam, lalu lepaskan. Anda perhatikan 

hasilnya. 
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Gambar 10. Rotasi Obyek 
 
Skewing Obyek 
1.  Aktifkan obyek Spiral sehingga muncul node. 
2.  Klik sekali lagi pada obyek tersebut sehingga node akan berubah 

menjadi anak panah. 
3.  Letakkan pointer pada panah horisontal yang terdapat pada bagian 

atas atau bawah obyek sehingga berubah menjadi . 
4.  Klik-tahan-geser kanan atau ke kiri, lalu lepaskan. Anda perhatikan 

hasilnya. 
 

 
 

Gambar 11. Skewing 
 
Catatan :  
Untuk Rotasi obyek dapat menggunakan node panah pada setiap pojok. 
Untuk Skewing obyek dapat menggunakan panah vertikal pada bagian 
kanan dan kiri obyek maupun horisontal pada bagian atas dan bawah 
obyek. 
 
 
Menggandakan obyek 
1.  Aktifkan teks “KOTA PALU “ sehingga muncul node. 
2.  Letakkan pointyer pada tanda silang di bagian tengah obyek 

sehingga berubah menjadi panah empat arah . 
3.  Klik-tahan-geser ke bawah. Sebelum klik di lepas, lanjutkan 

dengan klik kanan sehingga klik kanan dan kiri ditekan bersama, 
lalu lepaskan secara bersamaan. Anda perhatikan maka teks akan 
menjadi dua. 
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KOTA PALU 
 

Gambar 12. Menggandakan Obyek. 
 
4.  Aktifkan obyek polygon, sehingga muncul node. 
5.  Tekan dan tahan tombol Ctrl pada keyboard, lalu lakukan instruksi 

langkah ke 2 dan 3 diatas. Maka hasilnya akan berjajar vertikal. 
Mencerminkan Obyek 
1.  Aktifkan obyek teks. 
2.  Arahkan pointer pada node sebelah kanan obyek sehingga 

membentuk panah atas-bawah . 
3.  Tekan dan tahan tombol Ctrl pada keyboard, lalu klik-tahan-geser 

pointer tersebut ke bawah sampai melewati obyek. 
4.  Sebelum tombol Ctrl dan klik di lepas, klik kanan sehingga klik 

kiri dan kanan ditekan bersama. 
5.  Lepaskan klik kanan dan kiri, lalu lepaskan tombol Ctrl. Anda lihat 

hasilnya. 
 

KOTA PALU 
 
 

Gambar 13. Pencerminan Obyek 
 

Memberi Warna Fill dan Outline pada obyek 
1.  AKtifkan obyek persegi panjang sehingga muncul node. 
2.  Klik salah satu warna yang terdapat pada palet warna sebelah kanan 

untuk memberi warna fill. 
3.  Klik kanan pada warna yang lain untuk mengganti warna outline. 
4.  Lakukan perintah diatas untuk memberi warna pada obyek-obyek 

yang lain. 
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MENYIMPAN GAMBAR 

1. Klik menu File Save 
 

Gambar 14.   Save 
 

Klik Pada Save In untuk menentukan letak penyimpanan file 
2.  Klik pada File Name, lalu ganti nama Graphic1 dengan Latihan1 
3.  Klik tombol Save. 
 
MENGGAMBAR GARIS 
 
Membuat halaman baru 
 
1.  Klik menu Layout --> Insert Page 

 
 

Gambar 15. Insert Page 
2.  Klik tombol OK. 
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 Corel Draw menyediakan bermacam-macam tool untuk membuat 
garis antara lain Freehand Tool, Bezier Tool, Natural Pen Tool, 
Dimension Tool dan connector Line Tool. 

 
 

 
Gambar 16. Line Tool 

 
Keterangan : Urut dari kiri ke kanan masing-masing Freehand Tool, 
Bezier Tool, Natural Pen Tool, Dimension Tool dan Connector Tool. 
 
Membuat Garis menggunakan Freehand Tool 
1.  Klik icon Freehand Tool  . 
2.  Kik-tahan-geser ke sembarang tempat secukupnya lalu lepas. 
 
Membuat garis Menggunakan Bezier Tool 
1.  Kik icon Bezier Tool . 
2.  Leakkan di halaman, lalu klik disembarang tempat. 
3.  Klik lagi di tempat lain, lanjutkan klik ditempat lain sehingga 

saling tersambung. 
A.  MEMOTONG OBJEK 

1. Buat 2 buah objek yaitu Rectangle dan Ellipse. 
2. Tempelkan objek lingkaran di sisi sebelah kanan objek rectangle. 
3. Seleksi dua buah objek tersebut dengan menggunakan pick tool. 
4. Pilih : 

- Arange, Shaping, Trim. Hasil ……………. 
 

                    
 

B. MENGGABUNGKAN OBJEK 
1. Buat 2 buah objek yaitu rectangle dan ellipse. 
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2. Tempelkan objek lingkaran di sisi sebelah kanan objek 
rectangle. 

3. Seleksi dua buah objek tersebut dengan menggunakan pick tool. 
4. Pilih : 

- Arange, Shaping, Weld.                  Hasil ……… 
 

             
 

C. MENGATUR LETAK OBJEK 
1. Buat 2 buah objek yaitu rectangle dan ellipse. 
2. Seleksi dua buah objek tersebut dengan menggunakan pick tool. 
3. Pilih : 

-  Arange, Align and Distribut, kemudian pilih secara 
bergantian dari Align Left, Align Right, Align Top, Align 
Bottom, Align Centers Horizontally dan Align Centers 
Vertically. 

-  Amati hasilnya satu persatu. 



Halaman :  25 dari 114 
 

 

 
 

Hasil ……………… 
                                      

 
 
 

 

D. MEMBUAT GRUP OBJEK 
1. Selekssi dua buah objek lingkaran atau ellipse dan kotak atau 

rectangle. 
2. Pilih Arage, Group atau Ctrl – G. 

 
E. MEMATIKAN GRUP OBJEK 

1. Selekssi dua buah objek lingkaran atau ellipse dan kotak atau 
rectangle. 

2. Pilih Arage, Ungroup atau Ctrl – U. 
 
F. MENGGABUNGKAN OBJEK 

1. Selekssi dua buah objek lingkaran atau ellipse dan kotak atau 
rectangle. 

2. Pilih Arage, Combine atau Ctrl – L. 
 

G. DUPLICAT 
1. Buat objek lingkaran atau ellipse. 
2. Pilih menu Edit, Duplicate atau Ctrl – D. 
 

H. TRANSFORMASI OBJEK 

a.  Position (posisi objek) 
1. Buat objek lingkaran atau ellipse. 
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2. Pilih menu Arange, Transformations, Position atau Alt – F7. 
 
 
 
 
 
 
 
 

 
 
 

 
3. Ganti point yang ada di isian vertikalnya menjadi -0,4 inci. 
4. Klik Apply to Duplicate berulang – ulang. 
 
b. Rotasi Objek. 
1. Buat objek lingkaran atau ellipse. 
2. Pilih menu Arange, Transformations, Rotate atau Alt – F8. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

3. Isikan point untuk Angle : 5,0 Center Horizontal : 2,0  dan 
Center Vertiakal : 3,0. 

4. Klik Apply to Duplicate secara berualang hingga membentuk 
sebuah lingkaran ellipse. 

 
b.  Scale dan Mirror 
1. Buat objek lingkaran atau ellipse. 
2. Pilih menu Arange, Transformations, Scale atau Alt – F9. 
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3. Isikan Scale Horizontal : 115,0 dan Scale Vertikal : 110,0. 
4. Klik Apply to Duplicate berulang – ulang. 
 

I. MEMBUAT EFEK OBJEK 

a. Menggunakan Blend ( Objek bertumpuk). 
1. Buat dua buah objek ellipse seperti contoh di bawah ini. 
2. Seleksi dua buah objek tersebut. 
3. Pilih Menu Effects, Blend ……… 

 
 

 
 
 
 
 
 
 
 
 

4. Klik Apply 
 

b. Menggunakan Contour. 
1. Buat objek ellipse. 
2. Seleksi objek tersebut. 
3. Pilih Menu Effects, Contour ……… 
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c. Pilih Outside dan Offset : 0.11, Steps : 7 
d. Klik Apply. 
 

 
 

A.  MEMBUAT TULISAN MELENGKUNG 

1. Buat tulisan seperti di bawah ini : BELAJAR COREL DRAW 
2. Pilih jenis huruf pada properti bar atau font list, sesuaikan dengan 

keinginan anda. 
3. Perbesar huruf atau Sizenya menjadi 36 point. 

 
 
 
 
Catatan : 
Untuk memperbesar huruf dapat dilakukan dengan cara blok atau 
seleksi  atau klik sekali huruf tersebut kemudian lanjutkan dengan 
menarik node-nya. 
 

4. Buat lingkaran berbentuk oval. 
5. Blok dua buah objek tersebut yaitu teks dengan lingkaran. 
6. Klik menu Text, Fit Text to Path. 
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7. Atur pada properti text sesuai dengan keinginan. 

 
B. MEMBUAT BAYANGAN (SHADOW) 

1. Klik teks BELAJAR COREL DRAW tersebut. 
2. Klik Interactive Drop Shadow pada tool box. 
3. Pindahkan kursor mouse ke teks yang akan di shadow, klik dan 

tarik ke bawah. 
4. Lihat hasilnya. 
 

 
 
5. Atur properti drop shadow sesuai dengan keinginan. 

 
C. KERNING TEXT (OBJEK) 

1. Klik teks yang di shadow tersebut. 
2. Klik Effect, Add Perspective. Kemudian klik Shape Tool dan 

lanjutkan dengan mengklik nodenya sehingga teks nampak seperti 
di bawah ini. 
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3. Jika di inginkan jenis huruf yang lain dapat memilih pada properti 

D. EFEKS LENS PADA TEKS 

1. Buat objek lingkaran, besarnya sesuiakan dengan keinginan. 
2. Tempatkan objek lingkaran tersebut pada teks BELAJAR. 
3. Lanjutkan dengan memilih menu Effects, Lens. 

 
 
 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog Lens, pilih Wireframe pada list box lens. 
5. Jika belum diberi tanda cek pada Outline dan Fiil maka aktifkan. 
6. Klik Apply. 

  
E. COVERSI KE BENTUK KURVA 

1. Klik Basic Shape. Pilih pada properti bar : Perfect Shape seperti 
gambar di bawah ini. 
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Kemudian arahkan mouse ke bidang kerja, dan buat besarnya 
sesuai yang diinginkan. 

 
 
 
 
 
2. Klik Objek gambar shape tersbut, kemudian pilih menu Arange, 

Conver to Curve atau menekan Ctrl – Q. 
 

3. Klik Pick Tool kemudian edit objek shap tersebut sesuai dengan 
menggeser pada node – node nya sehingga tampak seperti gambar 
berikut. 

 
 
 
 

 
 
 
 
 
 
 
4. Sebagai latihan buatlah gambar seperti di bawah ini. 
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F. IMPOR GAMBAR 

1. Klik Menu File, Import. 

 
 
2. Pada kotak dialog import file, carilah gambar sesuai yang anda 

inginkan. 
3. Setelah mendapatkan gambar lanjutkan dengan mengklik button 

import. 
4. Arahkan pointer mouse ke area bidang kerja dan lanjutkan dengan 

menekan klik. 
5. Atur besarnya sesuai dengan keinginan anda. 

 
 
G. MEMOTONG OBJEK GAMBAR 

1. Klik objek gambar yang diimpor tadi. 
2. Klik Shape tool pada tool box, kemudian pilih Knife Tool. 
3. Pointer mouse akan berubah bentuk menjadi seperti pisau. 
4. Arahkan pada tepi atas objek gambar setelah arahnya berubah 

vertikal klik geser ke bagian tepi bawah objek gambar dan klik. 
Maka objek gambar tersebut akan terpotong. 

5. Geser hasil potongan tersebut ke samping hingga nampak dua 
buah objek hasil perpotongan tersebut. 
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6. Lanjutkan dengan memotong bagian objek gambar yang lain. 

 
H. POWER CLIP 

1. Buat objel ellpise atau lingkaran, atur beasrnya sesuai dengan 
yang diinginkan. 

2. Import gambar dan pilih gambar yang dianggap menarik, alangkah 
baiknya cari objek gambar foto. 

3. Seleksi Objek gambar yang diimpor tersebut. 
4. Pilih Effects, PowerClip, Place Inside Container. 
5. Pointer mouse berubah menjadi anak panah ke kanan, selanjutnya 

arahkan ke objek lingkaran dan klik. 
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Catatan : 
Kadang fasilitas ini kurang menarik atau kurang sesuai dengan yang 
diinginkan karena objek gambar yang diseleksi tidak terlihat pada objek hasil 
power clip. Namun bisa dilakukan dengan cara manual. 
 
 
6. Untuk latihannya buat objek gambar yang di import menjadi 

seperti berikut ini. 
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MENGGAMBAR LOGO 
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Implementasi : 

A. Membuat Polygon 

1. Pilih objek polygon pada menu tool box. Gunakan kombinasi 
tombol Ctrl untuk mendapatkan gambar yang simetris. 

2. Perhatikan hasil objek polygon di bawah ini : 
 
 

 
 

 Pilih Shape tool pada tool box. 
 Klik salah satau node yang dilingkari pada contoh gambar 

tersebut, kemudian tekan tombol delete yang ada di keyboard. 
 Secara keseluruhan 5 titik node tersebut akan hilang. 
 Lanjutkan dengan mengklik di sisi salah satu bidang atau ditempat 

node yang dihapus tadi. 
 Pada properti bar pilih Convert Line to Curve. 
 
 

 
 

 Lanjutkan dengan menggeser sisi bidang tersebut sehingga tampak 
semua sisi bidang menjadi melengkung. 

 Lihat gambar berikut : 
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3. Pilih Interactive Contour Tool pada Tool Box. 
 Tempatkan pointer mouse di salah satu sisi bidang. 
 Klik dan geser ke dalam bidang objek gambar. 
 Kemudian pisahkan objek hasil contour dengan cara memilih 

menu Arange, Break Contour Group Apart. 
 Ubah nilai line hasil contour menjadi 1.0 pt dan out line menjadi 

2.0 pt. 
 Kemudian seleksi dua objek line dan pilih menu Arange, Group. 
 Hasil. 

 
 

4. Buat lingkaran dengan menggunakan Ellipse Tool. Gunakan 
kombinasi tombol Ctrl pada keyboard untuk mendapatkan hasil 
yang lebih maksimal. 
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5. Tempatkan objel lingkaran tersebut pada posisi tengah objek 

polygon. Gunakan fasiltas menu Arange, Align and Distribute. 
Namun sebelumnya seleksi ke dua objek tersebut. 

 
B.  Membuat Teks Melingkar 

1. Lanjtkan dengan membuat teks “SEKOLAH TINGGI 
MANAJEMEN INFORMATIKA DAN KOMPUTER” dan teks 
“ADHI GUNA”. Atur posisinya sesuai yang ada pada gambar. 

2. Tambahkan objek gambar bintang di dua sisi bagian bawah objek 
polygon. 

3. Sesuaikan warna objek sehingga nampak seperti pada gambar. 
 
C. Menambahkan symbol/ Karakter sebagai objek gambar. 

1. Masukkan teks karakter dengan memilih menu Text, Insert 
Character. Kemudian pilih Webdings pada kotak isian Font. 

2. Pilih gambar komputer kemudian klik dan geser ke bidang kerja. 
3. Edit gambar tersebut hilangkan bagain yang tidak diperlukan, dan 

atur pewarnaan menjadi black and white. 
 
D.  Membuat objek buku 

1.  Buat sebuah kotak/ rectangle. 
2. Konversi ke bentuk kurva. Dan miringkan sudut kiri atas sehingga 

seperti berikut ini. 
 

 
 

3.  Pilih Shape tool, kemudian klik pada garis/line bagian atas. 
4. Pilih Conver line to curve pada properti bar. Lanjutkan untuk 

garis/line di bagain bawah rectangle atau kotak. 
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5. Atur lengkung line sehingga nampak seperti gambar berikut. 
 

 
 

6. Gandakan objek tersebut dengan cara :  
- Seleksi objek, kemudian tekan Ctrl, tanpa melepas Ctrl lanjutkan 

dengan mengklik node sebelah kiri dan geser kekanan, ikuti 
dengan mengkilik tombol mouse sebelah kanan. Kemudian lepas 
bersama – sama, hingga hasilnya seperti berikut : 

 

 
- Lengkapi gambar buku tersebut seperti pada gambar  di bawah ini. 
 

 
 
E. Membuat Pena 

1. Masukkan teks karakter dengan memilih menu Text, Insert 
Character. Kemudian pilih Wingdings 2 pada kotak isian Font. 

2. Pilih gambar pena kemudian klik dan geser ke bidang kerja. 
3. Edit gambar tersebut hilangkan bagain yang tidak diperlukan, dan 

atur pewarnaan menjadi black and white. 
4. Buatlah kreasi bulu dengan menggunakan Bezier Tool. 
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Menggambar buah 
 
 
 

 
 
 

Tool yang digunakan adalah Bezier Tools dan Text Tools 
 
Langkah Pembuatan 
1. Pertama, kita akan membuat objek buah. Gunakan Bezier Tools  

dan buatlah sketsa sebagai berikut : 
 

 
 

2. Gunakan Shape Tools   atau [F-10] lalu edit gambar tersebut 
hingga seperti di bawah ini : 
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3. Pilih Fill Tools, kemudian pilih Post Scrip Fill Dialog. Kemudian 

ikuti setting berikut : 
Post Scrip Texture : Archimedes, Frequency : 3, klik Preview Fill 
untuk mengetahui hasilnya. 
 

4. Klik OK Jika sudah. 
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5. Buatkan duplikasinya dengan menekan tombol + pada keyboard dan 
biarkan pada posisinya. 

6. Tekan tombol G pada keyboard atau pilih Tools Interactiv Fill 
Tools   dan atur propertinya seperti berikut : 
Fill Type : Linier dan Fill Drop Down : Red, Last Fill Picker : 
Brick Red, Fountain Fill MidPoint : 40 dan posisikan arahnya 
gradasi. 

7. Kemudian setting berikutnya adalah : Fountain Fill Angle and 
Edge Pad : -10 dan dan 17, lalu tekan enter. 

 

 
 
8. Langkah berikutnya adalah : pilih Interactive Transparancy Tools 

 dan arahkan pointer mouse kearah objek buah, kemudian klik dan 
geser ke arah gradasi. Dan lihat gambar. 

 

 
 
9. Kedua, kita akan membuat efek kulit dan cahaya. Klik Bezier Tools 

 kemudian buatlah dua buah sketsa objek gambar seperti berikut : 
 

 
10. Gunakan Shape Tools   atau [F-10] dan edit dua buah objek 

tersebut sehingga seperti nampak dibawah ini : 
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11. Tekan tombol G pada keyboard atau pilih Tools Interactiv Fill 

Tools   dan atur propertinya seperti berikut : 
Fill Type : Radial dan Fill Drop Down : 10% Black, Last Fill 
Picker : White, Fountain Fill MidPoint : 50 dan posisikan 
arahnya gradasi. 

12. Kemudian setting berikutnya adalah : Fountain Fill Angle and 
Edge Pad : 0 dan dan lalu tekan enter. 

 

 
 

 
 

Pilih Outline Width pada property bar menjadi 2.0 pt 
 

 
 

13. Posisikan kedua objek tersebut ke objek buah. 
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14. Ketiga, kita akan membuat bayangan lekukan. Gunakan Bezier 

Tools  dan buatlah sketsa gambar berikut ini : 

 
15. Gunakan Shape Tools   atau [F-10] dan edit dua buah objek 

tersebut sehingga seperti nampak dibawah ini : 
 

 
 
 
16. Beri warna keduanya dengan warna Black 20 %  kemudian 

posisikan pada objek daun pada buah sehingga nampak seperti 
gambar di bawah ini. 
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17. buatlah olbek path dengan menggunakan Bezier Tools   
kemudian edit dengan menggunakan Shape Tools   atau [F-10] 
sehingga terbentuk berikut ini : 

 

 
 
18. Posisikan di atas bayangan lekukan, lihat gembar berikut : 
 
 

 
 
 

19. Seleksi semua objek dan satukan dengan menekan pada keyboard 
[Ctrl-G], kemudian lanjutkan dengan menekan [Ctrl-D] untuk 
membuat duplikasi gambar buah. 

 
20. Pilih objek daun dan lekukan kemudian tekan Delete, kemudian 

seleksi buah dan pilih Horizontal Mirror Button pada property 
bar. Kemudian posisikan seperti pada gambar di bawah ini : 
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21. Keempat, kita akan melanjutkan dengan membuat objek ranting, 

gunakan Bezier Tools   dan buat sketsa seperti gambar di bawah 
ini: 

 

 
 
22. Gunakan Shape Tools   atau [F-10] untuk membuat objek agar 

lebih indah seperti gambar di bawah ini : 

 
23. Gabungkan objek ranting dengan buah, namun terlebih dahulu 

warnai ranting tersebut sehingga nampak pada gambar di bawah ini 
: 
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24. Kelima, kita akan membuat objek daun, gunakan Bezier Tools   

dan buat sketsa seperti gambar di bawah ini : 
 

 
25. Gunakan Shape Tools   atau [F-10] untuk membuat objek agar 

lebih indah seperti gambar di bawah ini : 
 

 
 

26. Berikan warna Green pada objek daun terebut. 
27. Buat objek path untuk memberi kesan serat pada daun. Seperti 

nampak pada gambar di bawah ini : 

 
 
28. Buat duplikatnya, dan posisikan pada objek daun. 
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29. Posiikan pada gambar buah, sehingga nampak pada gambar berikut, 
dan buat duplikasinya dengan menekan [Ctrl-D]. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Menggambar Objek Kuda Laut 
 
 
Untuk membuat objek kuda laut menggunakan empat tools freehand 
dan lima tools ellips. 
 
 

 
 
 

Ikuti langkah berikut : 
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1. Gunakan Freehand Tools  atau [F5] untuk menggambar sketsa 
badan. Klik Shape Tools  [F10] dan edit sketsa gambar seperti di 
bawah ini 
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2. Gunakan Fill tools untuk mewarnai objek gambar dengan memilih 
Fountain Fill Dialog [F11]dan ikuti setting ini : Type : Linier, 
Collor Blend : Two Color, From : Murky Green, To : Martian 
Green, Mid Point : 50 dan klik OK. 

 

 
 

 
 
3. Kedua, kita akan membuat arsiran perut. Klik Ellipse Tools, buat 

objek ellips dan posiskan sebagai berikut, kemudian klik menu 
Arange, Transformation, Rotate dan masukkan nilai -15 pada 
Angle, lalu klik Apply 
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4. Pilih menu Arange, Shapping > Shapping dan pilih Instersect. 

Beri tanda pada Target Object(s) kemudian klik Intersect With. 
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5. Klik Freehand Tools   [F5] dan buatlah objek segitiga. Gunakan 

Shape Tools  [F10] untuk mengedit objek tersebut dan posisikan, 
sehingga nampak seperti gambar di bawah ini : 
 

 
 

 

 
 
 
6. Klik menu Arange, Transformation, Rotate dan masukkan nilai -

15 pada Angle, lalu klik Apply. 
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7. Gandakan hingga menjadi tiga buah objek strip dan atur posisinya 

sesuai dengan gambar di bawah ini : 
 

 
 
8. Pilih menu Arane, Shapping > Shapping dan pilih Trim. Beri 

tanda pada Target Object(s) kemudian pilih objek badan dan klik 
Trim. 

 

 
 
9. Klik kedua objek (hasil intersect) lalu pilih Fill Tools kemudian pilih 

Fountain Fill Dialog (F11) ikuti setting berikut ini : Type : Linier, 
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Angle : 170, Color Blend : Two Color, From : Yellow, To : White, 
Mid Point : 1 dan klik OK. 

 

 
 

 
 

10. Seleksi ketiga objek tersebut hasil Trim lalu warnai dengan 
menggunakan Color Palette. 

 
11. Ketiga kita akan membuat Strip punggung. Gunakan Freehand 

Tools [F5] lalu buatlah objek seperti gambar berikut : 
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12. Gunakan Shape Tools  pada toolbox untuk mengedit objek 
tersebut, setelah itu tempelkan pada punggung objek kuda laut. 
Lihat gambar…. 

 

 
 
 

13. Klik Pick Tools  lalu pilih menu Arange, Shaping > Shaping 
dan pilih Trim. Beri tanda pada Source Object(s). kemudian klik 
objek badan dan tekan Trim.  
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14. Klik Strip punggung, pilih Fill Tools, Fountain Fill Dialog [F11] 
dan ikuti setting berikut : Type : Linier, Color Blend : Two Color, 
From : Green To : Blue, Mid Point : 50 klik OK. 

 

 
 
 

15. Keempat, kita akan membuat Strip kepala, gunakan Freehand Tool 
untuk menggambar objek, selanjutnya gunakan Shape Tools untuk 
mengedit objek strip kepala. Setelah selesai posisikan pada objek 
kepada kuda laut. 
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16. Pilih menu Arange, Shapping > Shapping dan pilih Trim. Beri 
tanda pada Source Object(s) kemudian pilih objek badan dan klik 
Trim. 

 
17. Klik Strip kepala, pilih Fill Tools, Fountain Fill Dialog [F11] dan 

ikuti setting berikut : Type : Linier, Color Blend : Two Color, 
From : Orange To : Green, Mid Point : 50 klik OK. 

 
18. Kelima kita akan membuat objek mata, gunakan Ellipse Tools. 
 
19. Klik menu Arange, Transformation > Rotate beri nilai 15 pada 

Angle dan klik OK. 

 



Halaman :  58 dari 114 
 

 
 
 

20. Selanjutnya mewarnai mata, Klik objek mata, pilih Fill Tools, 
Fountain Fill Dialog [F11] dan ikuti setting berikut : Type : 
Radial, Horizontal : 22, Vertikal : 22, Color Blend : Two Color, 
From : 20% Balck To : White, Mid Point : 50 klik OK. 

 
21. Keenam, membuat objek bola mata. Gunakan Ellipse Tools dan 

posisikan seperti pada gambar. 
 

 
22. Selanjutnya mewarnai bola mata, Klik objek mata, pilih Fill Tools, 

Fountain Fill Dialog [F11] dan ikuti setting berikut : Type : 
Radial, Horizontal : -1, Vertikal : -34, Color Blend : Two Color, 
From : White To : Yellow, Mid Point : 70 klik OK 

 
23. Keenam, membuat efek geleumbung air, gunakan Ellipse Tools 

dan buat lima buah objek gelembung dan posisikan sebagai berikut 
: 
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24. Gelembung ini akan kita warnai. Klik objek gelembung, pilih Fill 

Tools, Fountain Fill Dialog [F11] dan ikuti setting berikut : Type 
: Radial, Color Blend : Two Color, From : Ice Blue To : White, 
Mid Point : 50 klik OK 

25. Ketujuh, membuat hiasan ekor. Buat ellipse lingkaran dan 
posisikan pada ekor objek kuda laut. 

 
26. Pilih Fill Tools, Fountain Fill Dialog [F11] dan ikuti setting 

berikut : Type : Square, Horizontal : -24, Vertikal : 19, Color 
Blend : Two Color, From : Black To : Green, Mid Point : 50 klik 
OK 
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A. Mengenal adobe photoshop 
 
Adobe photoshop merupakan salah satu program 

pengolah grafis profesional standar, kinerja Photoshop dalam 
sebuah perusahaan percetakan biasanya dipadukan dengan 
program dengan program aplikasi DeskTop Publishing (DTP), 
seperti biasanya Adobe Pagemaker dan Quark Exspress. 
Publishing, Browsur, leaflet, pamlet, maupun poster dapat dibuat 
menggunakan adobe photoshop sedangkan sebuah buku yang 
terdiri atas teks dan gambar biasanya diproses menggunakan 
aplikasi desktop sedangkan sebuah buku yang terdiri atas teks 
dan gambar biasanya diproses menggunakan aplikasi DTP 
dengan dibantu Adobe photoshop sebagai pengolah 
gambarnya. Dalam hal ini, Photoshop digunakan untuk 
memproses gambar, menjadikannya layak cetak. 

Gambar (citra) yang dapat dimanipulasi menggunakan 
komputer adalah gambar digital. Merupakan proses menjadikan 
tampilan berbeda dengan sebelumnya dengan penambahan 
elemen dari citra lain atau dengan menggunakan  fasilitas filter 
dan efek dari program aplikasi grafis seperti photoshop ini.  

Dengan adobe Photoshop, sebuah foto atau gambar bisa 
dipresentasikan dengan format bitmap ber Resolusi tinggi. 
Resolusi menyatakan jumlah titik (pixel) per satuan luas, yang 
juga menunjukkan ketajaman dan detail gambar. Resolusi 
biasanya dinyatakan dalam satuan luas dpi (dot per inch). Selain 
resolusi, kualitas sebuah bitmap juga dicirikan oleh intensitas 
atau kedalaman warnanya. Kedalaman warna sebuah bitmap 
menentukan kualitas warna gambar secara keseluruhan. Dalam 
hal ini dikenal istilah 256 warna, high color, true color, skala 
keabuan (grayscale), serta hitam putih (black & white).  

Salah satu hal yang perlu Anda ingat adalah bahwa 
penggunaan program aplikasi photoshop ini biasanya 
dititikberatkan pada pengolahan yang sudah ada (foto dari 
kamera digital atau gambar hasil scanner). Jadi, Sebelumnya 
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anda belajar membuat (menggambar) grafis menggunakan 
CorelDraw, Pada bab ini anda akan belajar memanipulasi atau 
memproses gambar bitmap yang sudah ada. Namun, perlu juga 
diingat bahwa photoshop dapat juga digunakan untuk 
menggambar vektor meskipun mungkin terasa kurang.  

Adobe Photoshop yang akan kita pelajari kali ini adalah 
adobe photoshop CS3 (Creative Suite Tiga) atau versi 10. Untuk 
dapat menggunakan program aplikasi  tersebut anda harus 
meng-install-nya lebih dulu. 
 

Kreteria Komputer untuk Mengoperasikan PhotoShop CS3 
 

Processor Minimal Pentium III 
Raddom Access Memory (RAM) Minimal  512 Mb 
Monitor Super Video Graphics Array (SVGA) 
 
Cara Mengaktifkan Program Phoshop Cs3 

Klik Start, Program/All 
Program, Klik Adobe Photoshop CS3 
(seperti yang anda lihat pada gambar 
disamping), selanjutnya lihat tampilan 
Area Kerja Adobe Photoshop CS3 
seperti gambar dibawah ini. 

 
 
 
 
 
 
 
 
 
 

 
Gambar I.1 Area Kerja Adobe Photoshop CS3 

Palet Layer 

Options Bar 

Menu Bar 

Palet Styles 
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1. Menu Dan Ikon Pada Aplikasi Photoshop 

Cara mengakses / menggunakan berbagai menu pada 
photoshop tak jauh berbeda dengan cara penggunaan menu-
menu pada program aplikasi yang lain. Berikut ini akan 
dijelaskan beberapa menu utama photoshop beserta fungsinya. 
Seperti halnya program aplikasi grafis Coreldraw, menu-menu 
dalam program aplikasi photoshop ini secara umum terdiri atas 
pulldown menu dan toolbar menu atau toolbox.  

 
a. Puldown Menu 

Pulldown menu terdiri atas menu File, Edit, Image, Layer, 
Select, Filter, View, Window dan Help.  
1). Menu File 
 Menu File terdiri atas menu-menu yang berhubungan 

dengan file, seperti new (membuat file baru), open 
(membuka file), save (menyimpan file), save as 
(menyimpan file dengan nama / format lain), close 
(menutup file), print (mencetak file), dan exit (menutup 
aplikasi photoshop). Selain itu ada juga menu-menu lain 
yang dapat anda lihat sendiri pada waktu mengklik  
pulldown menu file ini.  

2). Menu Edit 
 Menu edit secara umum berisi menu-menu editing gambar, 

seperti undo (membatalkan satu perintah terakhir), copy 
(meng-copy gambar ataupu teks yang diseleksi ke 
clipboard tanpa menghapus objek sumbernya), clear 
(menghapus area gambar yang diseleksi), paste 
(menempelkan objek dari clipboard yang di-copy ataupun 
di- cut ke kanvas gambar), dan transform ( memutar dan 
mengubah ukuran area objek yang diseleksi).  

3). Menu Image 
 Menu Image berisi menu pengaturan gambar (properties) 

seperti mode (mengatur mode warna), Adjustment 
(mengatur kecerahan gambar), Duplicate (membuat 
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duplikasi  gambar), Image Size (mengatur ukuran dan 
resolusi gambar), Canvas Size (mengatur ukuran kanvas 
gambar), Rotate Canvas (memutar kanvas gambar), dan 
Crop (memotong gambar sesuai area yang diseleksi).  

4). Menu Layer 
 Menu Layer berisi pengaturan layer (lapisan-lapisan 

gambar), penggunaan layer dalam photoshop dapat 
mempermudah pemberian efek-efek transparansi yang 
membedakan tingkat kecerahan bagian gambar tertentu.  

5). Menu Select 
Menu Select berisi menu-menu pengaturan cara seleksi 
objek gambar.  

6). Menu Filter 
 Menu Filter berisi pengaturan efek-efek filtering yang 

cukup lengkap untuk mempercantik tampilan gambar anda.  
7). Menu View 

Menu View berisi menu-menu pengaturan tampilan 
gambar dalam area kerja photoshop.  

8). Menu Window 
Menu Window memuat pengaturan tampilan menu-menu 
berupa window (kotak kecil-kecil seperti navigator, layer, 
dan History). Menu-menu window tersebut dapat 
dimunculkan ataupun dihilangkan melalui pulldown menu 
Window ini.  

9). Menu Help 
Menu Help berisi menu bantuan untuk memahami dan 
mengakses petunjuk penggunaan Adobe Photoshop.  

 
b.  Mengoptimalkan Fasilitas bantuan pada Photoshop 

1. Fasilitas bantuan pada Photoshop meliputi ruler, guide, 
shortkey, dan toolbox. Ruler atau penggaris di tepi kanvas 
dapat digunakan sebagai panduan untuk membuat gambar 
dengan ukuran tertentu secara teliti. Ruler dapat dimunculkan 
ataupun disembunyikan dengan menekan tombol Ctrl+R. 
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satuan ukuran pada Ruler dapat diatur dengan klik kanan pada 
Ruler tersebut dan klik satuan (unit) yang diinginkan… 

2. Untuk mengoptimalkan penggunaan Ruler, anda dapat 
memunculkan guide, yang garis vertical ataupun horizontal 
untuk memudahkan pengaturan posisi objek. Klik Ruler bagian 
atas dan drag kebawah ke area kanvas untuk memunculkan 
horizontal guide. Untuk memunculkan vertical guide, klik ruler 
sebelah kiri kemudian drag ke kanan ke kanvas. 

3. Untuk mempercepat kerja anda efisiensi waktu, anda dapat 
menggunakan shortkey seperti Ctrl+S  untuk menyimpan, 
Ctrl+O untuk membuka file, Ctrl+N untuk membuka file baru, 
dan lain-lainnya. Hal ini cukup menghematwaktu anda 
meskipun pada awalnya anda harus menghafalnya. 

4. Toolbox yang berisi menu-menu standar editing sangat 
membantu proses manipulasi gambar. Dengan hanya satu klik, 
anda dapat mengakses fasilitas tertentu yang jika anda akses 
melalui pulldown menu membutuhkan beberapa langkah. Jadi, 
tollbox merupakan jalan pintas mengakses pulldown menu 
 

i. Menu Toolbox 
 

 Menu toolbox memuat beberapa menu editing 
gambar yang fungsinya kurang lebih sama dengan 
fungsi menu toolbox pada aplikasi Corel Draw 
yang telah anda pelajari. Dalam beberapa menu 
pada toolbox terdapat menu-menu lagi 
dibawahnya (dalam Corel Draw dikenal sebagai 
flyout).  

 
Menu Toolbox dapat dimunculkan ataupun 
disembunyikan melalui Pulldown menu Window-Tools. 
Beberapa nama dan fungsi yang terdapat pada toolbox, 
untuk lebih jelasnya  perhatikan gambar disamping. 
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Menggunakan Menu Toolbox untuk editing gambar 
a. Marquee Tool (M) 

 Digunakan untuk memilih 
bagian tertentu dari Image yang 
akan dimodifikasi atau dipotong 
(cut). Ada beberapa bentuk 
marquee tools yang dapat 
dimunculkan dengan klik kanan 
mouse di posisi marquee tool 

tersebut. Setelah pilih bentuk marquee, bawa kursor ke kanvas gambar, 
klik dan drag untuk melingkari atau meng-kotaki bagian gambar yang 
diinginkan. Bagian gambar yang terseleksi akan terlihat dikelilingi 
garis putus-putus. Perhatikan bahwa bagian gambar yang terseleksi ini 
terkait pula dengan layer mana yang sedang aktif. 
b. Lasso Tool (L) 

 Digunakan untuk memilih 
bagian dari image untuk 
dimodifikasi, sama fungsinya 
dengan marquee tool. Ada 3 Jenis 
lasso tool yaitu : Freehand Lasso 
Tool, Polygonal Lasso Tool, dan 
Magnetic Lasso Tool. 

Freehand Lasso tool digunakan untuk memilih objek dari satu image 
secara bebas. Caranya adalah klik bagian image sebagai awal proses, 
kemudian drag mouse selama memilih bagaian image. Lepaskan 
tombol mouse ketika titik awal bertemu dengan titik akhir pilihan. 
Setelah tombol mouse dilepas, image akan terlihat dikelilingi garis 
putus-putus. 
Polygonal lasso tool berfungsi memilih bagian yang berisi garis lurus. 
Cara mengoperasikannya mirip dengan freehand lasso. Magnetic Lasso 
tool dapat memilih sisi batas dari image dan mengaitkannya dengan 
freehand lasso dan polygonal lasso. 
c. Move Tool (v) 
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 Digunakan untuk menggeser atau memindahkan image 
(bagian image) yang diseleksi. Setelah objek (image) 
diseleksi, klik move tool kemudian bawa kursor ke kanvas 
gambar, klik dan drag hingga bagian gambar yang terseleksi 
akan bergeser. 
d. Magic Wand Tool (W) 

 Digunakan untuk memilih atau 
menentukan bagian gambar yang 
sama kedalaman warnanya. Cara 
pengoperasiannya: klik magic wand 
pada toolbox, bawa kursor yang telah 

berbentuk magic wand ke objek pilihlah suatu bagian dan klik dibagian 
itu sehingga muncul garis putus-putus yang melingkupi daerah gambar 
yang kedalaman warnanya sama. 
e. Cropping dan Crop Tool © 
 Cropping merupakan proses pemilihan bagian tertentu suatu 

gambar untuk dijadikan sebagai objek baru yang berdiri 
sendiri. Jadi, gambar yang beru hasil cropping hanya 
memuat bagian yang tadi diseleksi dari gambar 
induknya. 

 Contoh proses Cropping mula-mula digunakan marquee tool 
ataupun lasso tool untuk menyeleksi bagian gambar yang dimaksud 
klik pulldown menu image-crop hingga yang tersisa sekarang adalah 
bagian gambar yang anda seleksi tadi. 
 Proses cropping gambar dapat juga dilakukan melalui menu 
toolbox. Klik Crop Tool, bawa kursor kanvas, seleksi area yang 
diinginkan kemudian tekan tombol Enter (pada Keyboar). Misalkan 
anda kurang pas menyeleksi area gambar, anda bias menggeser area 
gambar tersebut atau jika ingin membatalkan seleksi area cropping tadi, 
tekan tombol Esc (pada keyboard) sehingga Anda dapat menyeleksi 
area kembali. 
f. Slice Tool (k) 

 Tombol ini digunakan untuk 
memotong gambar menjadi bagian yang 
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lebih kecil. Sering digunakan dalam layout table pada halaman web 
(HTML) 
g. Spot Healing / Healing Brush Tool(J) 

 Spot Healing Brush Tool / 
Healing Brush tool berfungsi untuk 
mengubah / memperbaiki bagian 
tertentu pada gambar menggunakan 
pola dari bagian gambar lain.  Spot 
Healing Brush tool, Healing brush 

tool dapat menyesuaikan warna, kecerahan, bayangan, dan tingkat 
transparansi gambar disekitar area yang diperbaiki. 
 Selain Spot Healing brush tool, healing brush tool, ada pula patch 
tool dan Red Eye Tool yang cara kerjanya mirip dengan healing tool 
ini. 
h. Brush Tool dan Pencil Tool (B) 

Fasilitas brush dapat juga dikombinasikan 
dengan marquee atau lasso tool sehingga 
bagian yang diarsir hanya terbatas pada 
bagian yang diseleksi saja. 

 Pencil Tool digunakan untuk menghasilkan goresan pada gambar seperti goresan pensil. Meskipun demikian, ukuran/tebal goresan 
i. Stamp (Clone Stamp) 
 Berfungsi untuk membuat 
duplikat dari suatu image sebagian 
atau seluruhnya, pada tempat dari 
image image itu sendiri atau halaman 
baru.  
j. History Brush Tool 
 History Brush Tool digunakan untuk menggambar (mengecet) 
dengan pola-pola gambar yang ada. Art History Brush digunakan untuk 

melakukan proses pengecatan dengan 
meniru bentuk guratan yang terdapat 
dibagian lain gambar.  
 Harus diingat bahwa history brush 
tool ataupun Art history brush yang 
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dapat diakses melalui toolbox ini berbeda dengan history window yang 
bisa dimunculkan atau disembunyikan menggunakan pulldown menu 
(Windows-History).  History window merupakan jendela yang berisi 
rekaman aktivitas yang kita lakukan terhadap gambar (image). Jika 
anda hanya menemui satu aktifitas yang biasa di undo menggunkan 
Ctrl+Z, History window menyediakan beberapa rekaman aktifitas yang 
memungkinkan kita kembali ke aktivitas tertentu (dengan cara 
mengklik daftar) untuk membatalkan aktifitas sesudahnya. 
k. Eraser Tool/Penghapus (E) 
 Terdapat beberapa tipe penghapus, yaitu eraser tool, background eraser tool, dan magic eraser tool. Eraser tool digunakan untmenghapus background hingga 

berbentuk transparan. Magic 
eraser digunakan untuk 
melakukan proses penghapusan 
daerah yang berwarna padat/jelas 

atau dengan kata lain menghapus secara selektif secara otomatis 
dengan hanya melakukan klik.  
I. Gradient dan Paint Bucket Tool 

 Gradient Tool digunakan untuk 
memberi warna gradiasi pada gambar. 
Warna yang digunakan bisa dipilih 
pada menu pewarnaan.Paint Bucket 

tool digunakan untuk memberi warna atau pattern/pola pada gambar. 
Apakah beda keduanya? Silakan anda menerapkannya pada gambar 
agar lebih paham. Gradient tool dan Paint bucket tool hanya dapat 
digunakan pada gambar raster. Gambar vektor yang akan anda beri 
efek gradiasi perlu dikonversi ke tipe vektor. Hal ini dapat dilakukan 
dengan klik layer tersebut kemudian klik kanan dam pilih (klik) 
Rasterize Layer.   
m. Pengolah Fokus (R) 
 Terdapat tiga macam tombol pengolah fokus, yaitu blur tool, 

sharpen tool, dan smudge tool. Blur tool 
digunakan untuk mengaburkan gambar. 
Sharpen tool digunakan untuk 
mempertajam gambar, sedangkan smudge 
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tool digunakan untuk memberi efek smudge (seperti terkena gosokan 
tangan). Klik salah satu dari alat tersebut pada toolbox kemudian 
lakukan dengan mengklik dan tahan mouse sampai efek yang 
dikehendaki muncul.    
n. Photography Tool (O) 
 Photography tool ini terdiri atas tiga macam, dodge tool, burn 

tool, dan sponge tool. Dodge tool 
digunakan untuk mengatur 
pencahayaan (exposure) agar lebih 
terang (light). Burn tool digunakan 
untuk mengatur pencahayaan agar lebih 

gelap (dark). Sponge tool digunakan untuk mengatur tingkat saturasi 
gambar.untuk mengoperasikannya,klik salah satu alat tersebut pada 
toolbox, kemudian lakukan dengan mengklik dan tahan mouse sampai 
efek yang dikehendaki muncul.  
o. Selection Tool (A) 

 Fasilitas ini digunakan untuk 
editing kurva vekor (bukan bitmap) 
baik terbuka atau tertutup. Bentuk 
kurva bisa dimodifikasi lebih lanjut 
dengan mengubah posisi serta arah 

segmen dan kait (anchor point). Selection tool ini juga dapat 
menyeleksi titik simpul untuk digeser atau pun dihapus. 
p. Type Tool (T) 

 Fasilitas type tool digunakan untuk 
membuat teks diatas gambar. Ada 
beberapa pilihan teks pada type tool ini, 
diantaranya adalah horizontal type tool 
dan vertical type tool. Horizontal type 

tool digunakan untuk membuat teks diatas gambar dengan orientasi 
mendatar (horizontal).Sedangkan vertical type tool digunakan untuk 
membuat tulisan dengan orientasi tegak (vertikal).     
q. Pen Tool (P) 
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 Ada beberapa tipe pen tool 
yang dapat digunakan untuk 
menggambar bentuk vektor. Pen 

tool digunakan untuk membuat gambar 
dengan tepi halus. Freeform pen tool 
digunakan untuk membuat pola 

gambar dengan garis bebas. Add anchor point tool digunakan untuk 
menambah titik simpul (anchor point) baru pada bagian objek berupa 
garis. Delete anchor point tool digunakan untuk menghapus titik simpul 
pada bagian gambar berupa garis. Convert point tool digunakan untuk 
merubah mode dari corner point (bentuk persegi) ke smooth point 
(bentuk kurva/lengkung) atau sebaliknya.  
r. Shape Tool (U)  

 Fasilitas ini digunakan untuk 
membuat bentuk-bentuk geometri 
standar, seperti yang sebagian sudah 
anda praktekan sebelumnya. Fasilitas 

ini terdiri atas rectangle tool,rounded rectangle tool, ellipse 
tool,polygon tool, line tool, dan custom shape tool.   
s. Notes Tool (N) 

 Notes tool digunakan untuk 
memberi catatanatau keterangan 
berupa teks (menggunakan notes tool) 
atau pun audio/suara (menggunakan 

audio annotation tool). 
t. Eye Dropper Tool,Color Sample Tool, dan Measure Tool 
 Eye dropper tool digunakan 
untuk meniru warna dari gambar 
yang sudah ada. Color sample tool 
digunakan unutk melihat nilai 
warna pada suatu daerah (titik). Measure tool digunakan unutk 
mengukur jarak antara dua titik pada gambar, dimana hasilnya akan 
tercantum pada property bar.  
u. Hand Tool (H) 
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 Tombol ini digunakan untuk menggeser gambar 
dalam kanvas (lembar kerja photoshop) sehingga bagian 
yang kita inginkan bisa kita lihat.Fasilitas ini digunakan 
jika gambar relatif cukup besar sehingga tidak semuanya 

terlihat pada kanvas. Klik hand tool kemudian klik gambar lalu 
geserlah (digulung) hingga terlihat bagian-bagian yang lain. Fasilitas 
ini dapat digantikan dengan menekan tombol spacebar (spasi) sambil 
men-drag gambar dikanvas. Fasilitas ini merupakan pengganti tombol 
scrool untuk menggulung tampilan gambar. 
v. Kaca Pembesar/Zoom Tool (Z) 

 Zoom tool digunakan untuk memperbesar atau pun 
memperkecil tampilan gambar/bagian tertentu dari 
gambar. Klik zoom tool kemudian klik pada gambar. 
Untuk memperbesar tampilan bagian tertentu pada 

gambar, setelah klik zoom tool lalu klik dan drag diarea gambar yang 
anda kehendaki. Fasilitas zoom tool ini bisa digantikan oleh tombol 
ctrl dan tombol + (plus) yang ditekan bersamaan untuk memperbesar 
tampilan gambar (zoom in). Untuk memperkecil tampilan gambar 
(zoom out),anda bisa melakukannya dengan menekan ctrl dan tombol 
– (minus) secara bersamaan. 
w. Foreground Color dan Background Color (D)       
 Bagian menu ini berfungsi untuk menentukan warna background 
dan warna foreground, anda cukup klik kotak bagian 

depan untuk memilih warna gambar, teks, atau objek 
lain yang terseleksi, sedangakan bagian belakang 

digunakan untuk mengubah warna background/latar 
dari lembar kerja (kanvas).   
 
6. Menggunakan Palette (palet) 
 Palet atau window digunakan sebagai perangkat bantu editing 
gambar agar lebih mudah dan cepat. Palet pada photoshop antara lain 
adalah navigator, info, color,  swatches, styles, history, action, layers, 
channels, paths, paragraph, tool preset, dan character. 
a. Navigator Palette dan Info Palette   
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 Navigator Palette digunakan untuk mengatur besar kecilnya 
tampilan ukuran gambar dalam lembar 
kerja (kanvas). Dengan kotak palet 
navigator,anda akan lebih mudah 
mengatur posisi tampilan image dilayar 
dengan cara menggeser slider atau 
memasukkan angka persentase (relatif 
terhadap ukuran asli gambar) disebelah 
kiri batang slider. Seperti diulas 
sebelumnya, palet ini dapat ditampilkan 
ataupun disembunyikan dengan cara 

mengklik pulldown menu windows-navigator.  
b. Color Palette, Swatches Palette,  dan Styles Palette 
 Color palette berfungsi untuk 
mengatur persentase (komposisi) campuran 
setiap komponen warna pada foreground 
dan background antara lain : R (Red), G 
(Green), B (Blue) dengan cara menarik 
slider/tombol geser pada setiap komponen 
warna atau dengan cara mengetikkan suatu 
nilai disebelah kanan setiap komponen warna. Cara menampilkan atau 
pun menyembunyikan fasilitas color palette adalah dengan klik 
pulldown menu windows-color. 
 Swatches pallete berfungsi mengatur warna dengan menggunakan 
palet warna. Pallete warna ini dapat dimunculkan ataupun 
disembunyikan menggunakan menu window-swatches. 
 Style palette digunakan untuk dasar pembuatan objek lain yang 
ingin dibuat dengan menggunakan efek serta sistem pewarnaan yang 
telah dibuat sebelumnya.Anda dapat menambahkan style baru pada 
palette dengan cara mengklik tombol panah disamping kanan atas dan 
kemudian memilih load style, kemudian pilih style yang anda inginkan. 
Cara menampilkan fasilitas style palette ini adalah dengan klik 
pulldown menu windows-style. 
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 Oleh karena ketiga palet tersebut terdapat dalam satu window, jika 
salah satu palet muncul, palet yang lain dapat dimunculkan dengan klik 
opsi yamg sesuai, misalnya,pada tampilan color palette, untuk 
mengakses style palette ansa tinggal klik opsi style. 
c. Layer Palette,Channel Palette, dan Path Palette 
 Layer adalah lapisan-lapisan bertumpuk yang membangun sebuah 

gambar. Gunakan layer palette untuk 
mempermudah mengedit dan 
memanipulasi gambar.  Ada beberapa 

tipe layer, diantaranya adalah normal layer,  
type layer, shape layer, mask layer, dan 
adjustment layer atau fill layer. Normal 
layer (raster) adalah layer yang 
biasanya berisi bitmap. Type layer 

adalah layer berisi teks (tulisan). Shape layer adalah layer yang berisi 
gambar vektor (bentuk-bentuk dari shape tool). Layer mask adalah 
layer yang berisi mask, sedangkan adjustment layer atau fill layer 
digunakan untuk mengubah pewarnaan pada gambar. 

Channel Palette  digunakan untuk merekam komponen warna 
yang digunakan dalam gambar. Bagian paling atas merupakan hasil 
perpaduan antara warna yang ada dibawahnya. Jika anda mematikan 
tampilan warna kompleks, seluruh komponen warna juga tak akan 
ditampilkan. Sebaliknya, jika komponen warna salah satu dimatikan, 
komponen yang lain akan tetap tampil,  gunakan tombol eye (gamabar 
mata) untuk mematikan atau jika ingin menampilkan hasil perpaduan 
warna. Pada Cannel Palette ini selain memisah warna, anda juga dapat 
melakukan seleksi untuk keperluan cropping dengan seleksi warna. 

Path palatte berfungsi untuk membuat pola garis yang nantinya 
akan digunakan memotong atau membuat pola gambar dengan vector, 
bagian gambar tersebut akan digunakan dapat ditampilkan kembali. 
d. History Palette dan Action Palatte 

History Palette atau History window 
berfungsi untuk proses undo, berbalik ke 
langkah pengolahan gambar sebelumnya. 
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Dengan kata lain History Palette merupakan alat rekam setiap 
langkah/prosesediting gambar yang akan kita lakukan. 

Action Pallette digunakan untuk mengeksekusikan perintah-
perintah tertentu secara otomatis. Dengan action. Kita bisa merekam 
(record) dengan mengeksekusi kembali (play) langkah-langkah dalam 
memanipulasi file/ gambar yang telah dilakukan. Action  sering 
digunakan untuk mempermudah dan mempercepat proses manipulasi 
agar tidak harus mengulang secara manual. Oleh karena bisa disimpan 
dalam bentik file (berekstensi *.atn) kita bisa tukar-menukar action. 
Selain itu,kita juga mempelajari langkah-langkah Action  milikorang 
lain dalam memanipulasi gamabar. Dengan menggunakan batch 
(diakses menggunakan pulldown menu File – Automate – Batch), 
Action bisa dieksekusi pada beberapa file gambar sekaligus. 

7.  MENGGUNAKAN FILTER 
Sebuah foto/gambar dapat diberi filter tertentu hingga terlihat 

warna tertentu yang dominan. Fasilitas filter dalam photoshop cukup 
lengkap, meliputi filterwarna, bentuk, dan tekstur. Dalam buku ini 
hanya akan ditunjukan penggunaan beberapa filter, anda harus 
mempelajari sendiri penggunaan dan bentuk filter-filter yang lain. 

Dalam gambar ….. ditunjukkan langkah-langkah memberi filter 
warna menggunakan polldown menu Image-Adjustment-Photo Filtter.  
Anda dapat memilih filter anda atau menggunakan setting yang sudah 
ada. Dalam gambar tersebut diperlihatkan contoh hasil filter dengan 
tipe worming filter (81) dan density 80%. Cobalah anda coba pilihan 
seting filter dengan nilai density yang bervariasi. Jangan lupa untuk 
mengaktifkan history palette agar anda dapat meng-undo langkah-
langkah anda dan lebih mudah membandingkan efek filter yang lain. 

Selain filter warna, anda dapat juga menerapkan filter tekstur. 
Fasilitas ini dapat anda terapkan pada gambar melalui pulldown menu 
filter-Texture. Dalam gambar 3.38  ditunjukan hasil memberikan 
filter tekstur yang disebut grain. Untuk tampilan hasil filter yang lain, 
silahkan anda mencobanya sendiri. 
8 Menggabungkan Gambar 
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Anda menggabungkan beberapa gambar menjadi satu dengan 
manipulasi yang menarik, misalnya, anda dapat mengubah latar 
belakang dari foto anda menjadi tempat-tempat lain yang mungkin 
belum pernah anda kunjungi.  Berikut ini akan diberikan contoh 
manipulasi gambar dimana dua orang anak ini yang berfoto diparkiran 
mobil Bandara Mutiara Palu  akan kita buat menjadi di depan 
Persawahan sekitar gunung berapa tempat Mbah Merijan Mengawali 
Karir sebagai Bintang Iklan Kuku Bima Rosa.  

Dalam hal ini, kita harus menyiapkan  kedua file gambar tersebut, 
file pertama adalah file berisi gambar anak-anak yang berpoto di 
parkiran bandara, sedangkan file kedua adalah file berisi latar 
Persawahan di Dekat Gunung Berapi Yogya. Kita akan menyeleksi 
foto kedua orang anak tersebut untuk berpose di depan Area 
Persawahan dekat gunung merapi di Yogya. 

Kita seleksi menggunakan 
Polygonal lasso tool  (dalam 
prakteknya, anda bebas 
menggunakan marquee ataupun 
lasso untuk menyeleksi). Setelah 
terseleksi, kita copy image  tersebut 
ke clipboard  dengan klik pulldown 
menu. Klik Edit Copy lalu pindah ke 
gambar persawahan klik edit paste, 
atau kita juga bisa menggunakan 
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move tool pada toolbox sehingga kita mendapatkan gambar berikut ini. 
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Beberapa Contoh Kegunaan Ikon dalam Tool Box 
 

Ikon Seleksi 
 
Dalam proses pengolahan image kadang kita memerlukan bagian 

tertentu dari image tersebut, untuk itu kita perlu menggunakan 
selection tool untuk memilih image yang diperlukan. Didalam 
photoshop terdapat beberapa kategori selection tools diantaranya 
adalah : Lasso Tools yang terdiri dari Lasso tools , tool ini 
menghasilkan seleksi yang baik tergantung ketelitian kita dalam 
menseleksi. Polygonal lasso tool hampir sama dengan lasso tools.  
Magnetik lasso tools untuk menseleksi dengan cara membaca warna 
dari image, jadi tergantung dari warna image. Tapi jika image yang 
diolah memiliki warna background yang polos maka akan lebih mudah 
lagi kalau kita gunakan Magic wand tools, kita tinggal klik daerah 
warna, maka akan langsung terseleksi bagian dari image tersebut, kita 
dapat memanfaatkan fasilitas toolbar selection untuk melakukan seleksi 
lebih jauh, adapun bagian dari selection toolbar diantaranya adalah: 
Add New Selektion, Add to Selection (untuk menambah seleksi baru 
selain seleksi sebelumnya),  Substract from Selection digunakan untuk 
mengurangi seleksi, Intersect with selection akan menghasilkan 
perpotongan antara area yang terseleksi. 
Fitur terbaru pada photoshop CS3 untuk Tool selection ini adalah 
Quick selection tools, bedanya tools selection ini memiliki pengaturan 
brush untuk menentukan ukuran seleksi, Hardness akan memberikan 
perubahan pada tepian seleksi.  
Marqee Tools akan membentuk seleksi sesuai dengan namanya 
misalnya rectangle marquee tool menghasilkan seleksi segi empat, 
Elliptical Marquee Tool akan menghasilkan seleksi lingkaran atau 
elips. 
Dalam seleksi terdapat fatheer untuk menentukan kehalusan tepian 
seleksi semakin tinggi nilai fatheernya semakin halus tepian seleksi,  
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Membuat Web Photo Galery 
Klik File, Automatic, Web 
Photo Galery, pilih style 
dari photo galery tersebut 
untuk ditayangkan 
diinternet, isikan alamat 
internetnya, pada source 
image kita tentukan letak 
photo tersebut, tentukan 
folder destinationnya 
misalnya my-documents, 
lalu photo, pilihan option 
kita pilih banner, dan 
berikan informasi 
pendukung pada bagian 
bawahnya, kemudian tekan 
ok, maka akan muncul 
internet explorer,  
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Mengkoreksi wajah yang jerawatan 
Gunakan spoot hilling brush tools, tentukan ukuran 
brushnya, tekan capslock, klikkan pada bagian wajah yang rusak, selain 
itu dapat juga digunakan healling brush, berbeda dengan spot healing 
brush untuk menggunakan healing brush kita harus menggunakan 
sample wajah yang mirip dengan daerah yang rusak, tekan tombol pada 
keyboard, klikan pada wajah yang rusak,  
 
Menghilangkan bagian tertentu dari Image 

Gunakan patch tools, perhatikan source, 
destination, transparant, Seleksi bagian image 
yang akan dipindah, 
pilih source untuk 
menghilangkan 
image, destination 
untuk menduplikasi 
image, transparant 
untuk membuat 
object  transparant, 
dekatkan kursor anda 
lalu klik geser 

seleksi tersebut,  
 
Menghilangkan mata merah Red eye Tools 
Gunakan Red eye tool, atur zoommingnya untuk membesarkan 
gambar, untuk menghilangkan efek mata merah,  seleksi bagian mata 
yang berwarna merah hingga efek merah hilang. 
 
 
 
 
 



Halaman :  80 dari 114 
 

Mengubah warna rambut pada Photo anda 
Siapkan Photo klik,  Edit in Quick Mask,  

Atur ukuran brushnya, sapukan ke bagian 
rambut, klik lagi edit in Quick Mask, klik 
Menu select, Invers (membalik seleksi), 
klik layer, pilih new fill layer, solid color,  
pada pilihan mode pilih softlight atau 
pilihan 
yang lain,  
lalu klik ok 
lalu 
tentukan 

warna yang sesuai dengan selera anda 
misalnya warna agak kecoklatan seperti 
yang anda lihat pada gamber sebelah 
kanan ini,  klik Ok.  
 
 
Memberi Efek cahaya pada Photo 

Menyinari 
bagian 
tertentu dari 
sebuah 
photo/Image 
(omni) 
 Klik menu 
filter, render, 
lightening 

efek tentukan stylenya, flaslights, pilih typenya misalnya omni, 
tentukan area,  lalu atur ketajaman sinar dengan menggeser slider ke 
arah kanan atau kiri. Pilih save ketikan namanya, misalnya cahaya klik 
ok, maka  secara otomatis akan muncul pada pilihan style. Untuk 
memperindah photo tambahkan efek lagi melalui Filter, render  yaitu 
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lens flare, atur brightness dan lens typenya mis  alnya 35 mm frame, 
tekan ok . 
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Mengisi Bingkai / Frame pada Photo 
Untuk mempercantik image biasanya sebuah photo diberi 
bingkai/frame  
Buka image photo 
dan buka image 
bingkai kemudian 
buka kunci photo 
double klik layer 
background, klik 
Ok, kemudian klik 
and drag pada 
image frame, atur 
letaknya layar 
frame pada bagian 
atas, kemudian 
tekan kontrol T 
untuk mengatur 
ukurannya. 
Kemudian tekan 

enter 
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Teknik Menghilangkan Back ground pada photo / image yang 
helaian rambut yang kurang rapi. 

Kita dapat menggunakan 
Polygon Lassotools, tapi tidak 
efektif ada helaian rambut yang 
akan terpotong, atau Magic 
wand tools kemungkinan ada 
bagian dari image yang tidak 

ingin kita seleksi terseleksi, langkah 
yang paling tepat kita akan 
menggunakan fasilitas menu  filter 
kemudian dengan menu ini kita bisa 
memilih dan menghilangkan bagian 
tertentu dari image tanpa merusak 
helaian-helaian rambut pada image 
tersebut. 
Klik Filter, extract, tentukan ukuran dari brush, agar hasil seleksi 
terlihat tajam, pastikan smart lighting dalam keadaan terpilih, kita 
seleksi pada bagian 
bawah rambut, hilangkan 
tanda pada smartlighting 
kemudian pilih pada 
bagian rambut, pastikan 
bagian yang berwarna 
hijau ini saling bertemu, 
klik paint bucket dan 
klikkan pada area image 
yang diseleksi, area yang 
berwarna biru adalah 
area yang  tidak 
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terpotong, kemudian tekan preview kemudian tekan ok. 
Untuk melihat hasilnya  kita cek dengan menambahkan layer baru, dan 
kita ubah warna backgroundnya. 
Memberi Efek kabur pada Photo / Image 

Blur  disebabkan karena karena 
kamera tidak dilengkapi auto 
focus, objek yang dipoto jaraknya 
terlalu jauh lalu kita mencoba 
memaksakan kamera dengan 
fasilitas zoomnya, tangan yang 
tidak stabil dalam menjepret 
photo juga salah satu 
penyebabnya efek blur. Kita 

dapat membuat sendiri efek blur 
adapun langkah-langkahnya adalah 
sebagai berikut : 
Kita seleksi objek dengan 
menggunakan polygon lasso tools, 
objek yang terseleksi akan terkena 
efek blur, untuk membalik klik filter 
invers, kuat lemahnya efek blur ini 

ditentukan oleh nilai yang 
diberikan pada distance, 
tentukan sudut arah efek 
blurnya, gunakan radial blur 
pilih zoom, tentukan nilai 
amount untuk menentukan 
kuat lemahnya efek yang 
dihasilkan. Tekan ok lalu 
hilangkan seleksinya dengan 
memilih select, deselect. 
Maka anda akan melihat 
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gambar selain anak yang berbaju hitam menjadi lebih kabur dengan 
sudut 45o 
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Membuat photo dramatis 
Harus ada image yang sesuai untuk membuat efek ini, lakukan 

duplikasi  kemudian pilih 
filter, artistik, plastic wrap 
berikutnya kita atur  
parameternya kemudian 
tekan ok, pada blanding 
mode kita rubah menjadi 
multifly, kemudian kita 
hapus area yang tidak kita 
inginkan untuk diberi efek, 
gunakan layer mask, klik 
layer tumbhnail, pilih 
erase tool, kemudian hapus 
area yang tidak diberi efek, 
kalau sudah kita 

tambahkan fill or 
ajustment layer, kemudian 
pilih black and white, 
blending mode kita ganti 
menjadi overlay, kita 
ubah warna, pada layer 
background copy pilih 
layer thumbnail,  
kemudian klik menu 
image, adjusment, pilih 
hue or saturation untuk 
memberikan warna yang 
berbeda pada bagian 
image, kemudian tekan 
ok. 
 
Situs  Http://www.Photoshoptutorial.com 
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Membuat photo horor 
 

Siapkan image yang sesuai, lakukan duplikasi, klik kanan duplicate 
layer, Ok.  

Berikut kita gunakan brush tool kita atur 
warnanya misalnya merah tua, atur ukuran 
brush, 
Hardnessnya 100%, klikan pada area mata,  
pilihan blending mode ganti menjadi overlay, 
Tambahkan layer baru gunakan paint brush 
atau brush tool namun kita ganti warnanya 
menjadi biru tua, kemudian atur brushnya 
kita letakan paint brush ini pada area sekitar 
mata kita ganti ukuran brush kecilkan letakan 
sekitar area hidung, mulut kemudian blending 
mode ganti 

menjadi  overlay . agar lebih realistis 
gunaan image, adjusment hue or 
saturation, hue beri nilai + 
saturation beri nilai - . berikan pula  
pada layer background copy. Masih 
menggunakan hue or saturation, untuk 
mengaturnya bila perlu 
menggunakan / centang pada 
colorize, kemudian atur hue dan 
saturasinya. Berikan angka 284 pada 
hue 8 point pada saturation, -14 pada lightnes atau kreasi anda sendiri. 
Jika sudah tekan ok. 
 
Mengubah Photo Hitam Putih menjadi Berwarna 
Jika mengubah Image dari berwarna menjadi hitam putih caranya 
mudah  
Ubah mode warnanya pilih Image, Mode, Grayscale, pilih dicard Atau 
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Ubah mode warnanya pilih image, Adjusment, Black and white,  
 
Siapkan Image yang tidak berwarna, lakukan duplikasi, selanjutnya 
seleksi bagian-bagian image yang akan kita beri warna, klik add layer 
mask, kemudian pilih layer thumbnail, pilih Image, adjusment pilih hue 
and saturation, kemudian kita atur, hue, saturation, lightnessnya dengan 
menggeser slider pada masing-masing bagian tersebut, misalnya kita 
akan beri warna merah pada bagian baju. 
Kemudian pada layer 0 duplikasi lagi, kemudian seleksi pada bagian 
background,  langkah yang sama setelah seleksi tambahkan add layer 
mask,  pilih layer thumbnailnya pilih image, Adjustmen, channel 
mixer, rubah parameternya, klik ok, kemudian duplikasi lagi layer 0, 
kita seleksi pada bagian wajah, jika sudah tambahkan kembali add 
layer mask, klik layer thumbnail, klik image, adjusment,  
hue/saturation,  atur hue, saturation dan lightness, bila perlu centang 
pada bagian colorize, atur hue saturation dan lightness,  tekan oke. 
 
Suasana Pagi hari, 
Buka Photo yang sesuai 
Buat layer baru dan beri warna putih,  agar terkesan tipis, atau 
opacitynya, kemudian duplikasi sebanyak 3 x,  
Sekarang kita hapus secara acak tiga layer ini, kemudian pada layer 
bagian atas tambahkan fill or adjusment,  pilih photo filter, kita 
gunakan warming filter,  dan densitynya diberikan nilai 50%. Tekan 
ok, agar lebih, agar lebih dramatis tambahkan filter, distorsi, lens 
correction, tarik keatas pada layer kemudian tekan Ok. Untuk mengatur 
suasananya, pilih layer 0, pilih Image, adjusment, color balance,  
berikan nilai pada cyan, magenta dan yellow, klik Ok. 
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Smart Filter 
Buka Gambar/Photo yang akan dibuat smart Filter 
Klik Filter, Convert for Smart 
Filter, kemudian Klik layer, 
convert to smart Objek,  kemudian 
kita akan memberikan efek pada 
photo tersebut, klik filter, distort, 
spherize, tentukan pengaturannya, 
kemudian tekan ok, perhatikan 
pada panel layer akan terbentuk 
smart filter dan efek yang 

digunakan, kemudian kita buat 
efek lagi, klik layer, blur, radial 
blur, tentukan pengaturannya, 
klik ok. 
 
 
 
 
Penggunaan smart filter ini 

memungkinkan kita menggunakan lebih dari satu efek pada satu layer, 
kita pun bisa melakukan pengeditan pada efek-efek yang telah kita 
berikan, dengan cara mendouble klik efek yang kita ingin edit. 
Biasanya kalau kita  memberikan efek pada suatu objek biasanya efek 
menjadi satu dengan image aslinya. Namun dengan smart filter kita 
masih bisa menampilkan efek aslinya. Dengan mengubah terlebih 
dahulu warna foreground dengan background. 
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Clipping Mask 
 

Clipping Mask berfungsi untuk “memasukan” sebuah gambar atau foto 
ke dalam objek tertentu yang kita buat. Walaupun cara kerjanya 

sederhana, tapi acapkali prosesnya 
terbolak-balik sehingga clipping 
mask ini tidak bisa bekerja sama 
sekali.  
Menggunakan Clipping Mask 
Dikarenakan clipping mask 
berfungsi untuk memasukkan 
sebuah gambar ke dalam objek, 
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maka paling tidak harus ada dua unsur di sini, yaitu gambar dan 
objeknya. 
Berikut langkah-langkah pengunaannya: 
1. Pertama-tama, buka file gambar. 

2. Klik ganda pada Layer Background yang 
ada di dalam panel Layer. 

3. Buka kunci file image tersebut dengan 
mengklik ganda, tekan  tombol Ok dialam 
jendela New Layer. 

4. Dengan demikian, layer Background akan 
berubah menjadi Layer 0 

5. Pilihlah Custom Shape Tool, lalu pilih salah satu shape yang 
sesuai 

6. Didalam kota Shape, pilih salah satu 
bentuk yang Anda sukai. 

7. Buat objek yang sudah anda pilih di 
dalam kanvas dengan mengklik dan 
men-drag-nya. 

8. Beralih ke panel Layers 
9. Klik dan drag Layer 0 ke atas Layer Shape 1 
10. Pilih menu Layer > Create Clipping Mask 

11. Bentuk objek yang ada 
di dalam kanvas akan 
menjadi seperti gambar 
di bawah ini. 

12. Klik Layer Shape 1 
terlebih dulu. 

13. Pilih Menu Layer 
>Layer Styele> Drop 
Shadow 

14. Untuk bayangan, 
gunakan setting 
dibawah ini: 

Opacity   :  75% 



Halaman :  93 dari 114 
 

Anggle     :  30 
Distance  :  5px 
Spread     :  10 
Size           : 5 px 
15 Klik pada Opsi Bevel and Emboss 

untuk mengaktifkannya. 
16  Untuk Structure pada Bevel and 
Emboss, gunakan setting berikut 
Style           :  Inner Bevel 

Technique : Smooth 
Depth         : 100% 
Size             : 32 px 
Soften        : 0 px 

17  Sedangkan untuk Shading, 
masukkan setting di bawah ini 
: 
Angle    : 30 
Altitude   : 30 

Warna Shadow Mode : Merah tua 
(#660000) 

Tekan Tombol Ok dan anda akan 
melihat gambar dibawah ini. 
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Refleksi 

Ada beberapa tahapan dalam yang harus dilalui dalam membuat 
refleksi (pantulan). Tapi pada intinya, kita akan menggunakan Layer 
Mask dan Gradient Tool untuk menciptakan refleksi yang realitis. 
1. Buka File gambar yang sesuai 

2. Tekan 
Ctrl 
+ A 
unt
uk 
me
nse
lek

si 
sel

uruh kanvas 
3. Kemudian, tekan Ctrl  + X 
4. Lanjutkan dengan menekan tombl Ctrl 

+ V agar foto itu berpindah di 
layer baru 

5. Pilih menu Edit > Transform>Scale 
6. Masukkan angka 50% di 

Kota W serta 
H. 

 
 
 
 
7. Klik Ikon Commit    

yang ada di sisi kanan 
Options Bar 

8. Pilih Move tool yang ada di toolbox 
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9. Posisikan foto tadi di sisi atas pada kanvas seperti terlihat pada 
gambar dibawah ini. 

10. Tekan tombol Atl+Klik dan drag foto itu ke arah bawah untuk 
menduplikat sekaligus 
menggandakannya. 

11. Pilih menu Edit>Transform>Flip 
Vertical. 

12. Posisikan lagi foto hasil 

duplikasi agak ke bawah agar memiliki jarak 
dengan foto aslinya. 

13. Klik ikon Add Layer Mask    yang ada di dalam 
panel Layer bagian bawah. 

14. Klik Gradient Tools   dari dalam toolbox.  
15. Pilih Warna gradasi hitam putih seperti 

ditunjukkan pada gambar dibawah ini.  
16. Klik dan drag dari arah bawah keatas pada objek foto bayangan 

yang ada di kanvas. 
17. Lepas tombol kiri mouse dan anda 

akan melihat hasil seperti gambar 
berikut 

18. Tekan tombolk Ctrl + Klik pada 
layer 1 sehingga Layer 1 copy dan 
Layer 1 dalam keadaan terpilih. 

19. Pilih Menu Edit> 
Transform>Distort 

20. Klik dan drag handle di pojok kiri atas ke arah bawah. 
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21. Selanjutnya, klik dan drag handle di pojok di pojok kiri bawah ke 
arah atas. 

22. Klik ganda didalam foto itu sehingga hasil final yang akan dapat 
tampak seperti gambar di bawah ini. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Smart Object 
 

Salah satu fasilitas canggih yang ada di Photoshop CS3 adalah 
Smart Object. Memang Smart Object jarang di manfaatkan oleh 
pengguna awam karena ketidaktahuan mereka tentang fungsi 
sebenarnya dari Smart Object ini. Di sini, kita akan belajar lewat 
latihan untuk mengeksplorasi fungsi Smart Object, dan bagaimana 
fungsi ini dapat membantu kita mempercepat sebuah proses mendesain 
gambar. 
 
Membuat Objek Utama 
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Pertama-tama, kita rancang dulu objek yang akan di jadikan Smart 
Object. Objek tersebut bisa berbentuk teks, gambar, atau lainnya. Tapi 
dalam contoh kasus ini, kita akan menciptakan Smart Object berbentuk 
tek 
Berikut langkah-langkah membuat objek utama: 
 
1. Buatlah kanvas baru 

dengan ukuran 500x100 
pixels. 

2. Klik ikon warna latar 
depan dan ganti dengan 
warna kecoklatan 
(#ffc06e). 

3. Tekan tombol OK. 
4. Kemudian, klik 

Rectangle Tool dari 
dalam toolbox.  

5. Buat persegi empat di 
dalam kanvas yang memanjang menguasai isi seluruh kanvas 
seperti gambar di bWh ini. 

6. Arahkan kursor mouse di atas Layer Background. 
7. Tekan tombol OK untuk kotak dialog New Layer. 
8. Setelah itu, dalam keadaan Layer 0 terpilih, klik menu Layer > 

Delete > Layer. 
9. Hasilnya, latar belakang di 

dalam kanvas akan menjadi 
transparan. 

10. Pilih menu Layer > Layer Style > Drop Shadow. 
11. Gunakan setting default untuk bayangan dibelakang persgi empat 

tersebut. 
12. Kalau sudah, klik pada opsi 

Stroke. 
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13. Di bagian Size, masukan angka 8, di bagian Position, pilih Inside. 
14. Klik kotak Color dan pilih warna coklat muda (#ffd599). 
15. Tekan tombol OK dan pastikan setting Stroke yang lain tampak 

seperti gambar di bawah ini. 
16. Tekan tombol OK lagi dan bentuk segi empat akan berubah sedikit 

karena sudah ada penambahan bayangan dan stroke. 
17. Tekan huruf D untuk mengembalikan posisi warna default. 
18. Pilihlah Horizontal Type Tool dari toolbox. 
19. Klik di dalam kanvas dan ketik teks sesuai selera Anda sendiri. 
20. Pilih lagi menu Layer > Layer Style > Drop Shadow. 

21. Biarkan setting default untuk 
drop shadow apa adanya 
(tidak berubah). 

22. Klik Bevel and Emboss dan 
pakai juga setting default 
tanpa perubahan berarti 
(ubah sesuai selera Anda 
jika perlu). 

23. Klik Stroke. 
24. Untuk warnanya di kotak 

Color, pilihlah warna putih. Sedangkan setting Position, pilihlah 
Outside dengan Size sebesar 3px. 

25. Tekanlah tombol OK. 
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26. Pilih menu File > Save As. 
27. Simpan dengan nama “teks.psd” di dalam hard disk Anda. 
 
 
 

Inilah hasil akhirnya 
 
Memasukkan Smart Object 
Inti utama Smart Object terletak pada objek itu sendiri yang bisa di edit 
secara langsung dan mudah ketika kita mengubah file asli Smart Object 
tersebut. 
 
Berikut langkah-langkah untuk memasukkan Smart Object: 
1. Tutup dulu kanvas file “teks.psd” yang masih ada di jendela 

Photoshop CS3. 
2. Buka file foto yang Anda miliki (terserah, bisa foto apapun sesuai 

dengan selera dan keinginan Anda). 
3. Pilih menu File > Place. 
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4. Buka file “teks.psd” yang ada di dalam CD. 
5. Tekanlah tombol Place untuk meletakkan teks itu ke dalam kanvas. 
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6. Klik ganda di dalam Smart Object itu dan di dalam Layer Teks akan 
muncul persegi empat kecil yang menunjukkan bahwa layer itu 
mengandung Smart Object. 

7. Pilihlah menu Edit > Transform > Warp. 
8. Klik menu drop-

down Wrap 
yang ada di 
toolbar. 

9. Pilihlah Flag. 
 
 
 
 
 
 
 
 
 
 
 

10. Klik ikon √ yang ada di toolbar sehingga teks di dalam kanvas akan 
berkibar seperti layaknya bendera (lihat gambar berikut ini). 

  
9. Beralihlah kedalam panel Layers dan turunkan nilai Opacity 

menjadi kira-kira 75%. 
10. Hasil akhir teks itu akan tampak seperti gambar di bawah ini. 
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11. Sekarang kita akan menguji kecanggihan Smart Object. Caranya, 
arahkan kursor mouse ke kotak kecil hitam-putih di samping 
kanan bawah pada Layer Teks. 

12. Klik ganda dan tekan tombol OK jika muncul kotak dialog seperti 
gambar di bawah ini. 

13. Tunggulah beberapa saat sampai jendela kanvas file “teks.psd” 
akan terbuka lagi. 

14. Sekarang, pilihlah Horizontal Type Tool. 
15. Klik layer tempat teks berada di dalam panel Layers 
16. Ganti teks yang ada di kanvas dengan teks Anda sendiri, seperti 

contoh berikut. 
17. Klik Move Tool 

dan ketengahkan teks 
itu di dalam kanvas. 

18. Kemudian, pilih 
menu File > Save. 

19. Tutup kanvas file 
“teks.psd” dan amati 
yang terlihat di 
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dalam kanvas tempat kita memasang Smart Object tersebut. 
 

 

Inilah kecanggihan 
Smart Object di 
atas. Dengan 
mengubah file 
aslinya, perubahan 
juga akan di lakukan 
pada teks yang kita 
letakkan di dalam 
foto di atas sebagai 
Smart Object secara 
otomatis. 

 
 
 

Motion Blur dan 
Polar Coordinates 

 
Ada banyak cara untuk menciptakan efek spesial. Anda bisa memakai 
salah satu filter yang ada di Photoshop CS3 atau menggabung 
beberapa filter sekaligus untuk mendapatkan efek tunggal yang 
menarik. Di sini, kita akan memadukan Motion Blur dan Polar 
Coordinates untuk menciptakan efek zoom. 
 
Motion Blur dan Polar Coordinates 
 
Pertama-tama kita membutuhkan foto yang menarik dan sebisa 

mungkin objek utama ada di 
tengah karena menjadi fokus 
perhatian. Setelah itu, kita akan 
padukan menggunakan Motion 
Blur dan Polar Coordinates. 
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Berikut langkah-langkahnya: 
 
1. Buka file Foto anda yang ada media 

penyimpanan 
2. Gandakan Layer Background dengan 

mengklik menu Layer > Duplicate layer. 
3. Tekan tombol OK. 
4. Pastikan Layer Background Copy 

dalam keadaan aktif. 
5. Pilih menu Filter > Distort > Polar 

Coordinates. 
 
6. Kemudian setelah Anda 

berada di dalam jendela Polar 
Coordinates, pilihlah opsi 
Polar to Rectangular. 

7. Tekan tombol OK untuk 
mendapatkan efek seperti 
gambar berikut. 

8. Pilih menu Filter > Blur > 
Motion Blur. 

9. Setelah itu, gunakan spesifikasi 
berikut ini: 
 Angle               : -90 
 Distance          : 355 pixels 

10. Tekan tombol OK dan Anda 
akan melihat efek-efek 
motion blur yang kuat 
seperti pada gambar 
berikut. 

 
11. Pilih menu Filter > Distort 

> Polar Coordinates lagi. 
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12. Pilih opsi Rectangular to Polar. 
 
 

 
 
 
 
 
 
 
13. Tekan tombol OK. 
14. Pilihlah Elliptical Marquee Tool dari dalam toolbox. 
15. Di toolbar, masukkan angka 100 px di kotak Feather. 
 

16. Buat bidang seleksi 
berbentuk lingkaran di 
dalam kanvas seperti 
gambar di bawah ini. 

17. Tekan tombol Delete 
untuk menghapus area 
yang terseleksi. 

18. Kalau sudah, tekan 
tombol Ctrl + D untuk 

menghilangkan seleksi. 
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Pelangi 
 
Anda bisa menciptakan efek apapun yang menarik asalkan tahu 
bagaimana prijnsip seleksi yang rapi dan rumit. Contohnya pada kasus 
berikut ini, dimana kit akan meletakkan objek pelangi di balik pohon-
pohon. Masalahnya, kita harus menghapus objek langit pada foto 
terlebih dulu. 
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Membuat Objek Pelangi 
 
Untuk menyeleksi objek langit dan kemudian menghilangkannya, kita 
akan memakai salah satu fasilitas yang ada di dalam Photoshop CS3, 
yaitu Channels. 
 
Berikut langkah-langkah untuk 
membuat objek pelangi: 
1. Buka file “pohon.jpg” yang 

ada di dalam CD dan lihat 
hasilnya pada gambar di 
bawah ini. 

2. Masukkan ke dalam panel 
Channels. 

3. Klik Channel Blue yang ada 
di dalam panel Channel tersebut. 
Klik kanan di atas Channel Blue tersebut. 

4. 

plicate Channel 
sehingga muncul 
channel baru bernama 
Blue Copy. 
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5. Pilih menu Image > 
Adjustments > 
Levels. 

6. Masukkan angka 0 |0,29 
|169 di dalam jendela 
Levels itu. 

7. Tekanlah tombol OK. 
8. Kliklah Brush Tool dari 

dalam toolbox. 
9. Oleskan Brush Tool itu ke objek pohon agar objek pohon-pohon itu 

menjadi hitam 
seluruhnya. 

10. Tekan huruf X untuk 
memposisikan warna 
putih sebagai warna 
latar depan. 

11. Kemudian, sapukan 
Brush Tool itu ke area 
langit yang telah 
berwarna putih sehingga area tersebut benar-benar putih tanpa ada 
noda-noda hitam. 

12. Klik channel RGB lagi 
untuk menormalkan warna-
warna pada foto. 

13. Aktifkan panel Layers. 
14. Klik ganda Layer 

Background dan tekan tombol  
OK untuk kotak dialog New 
Layer sehingga layer itu 
berubah menjadi Layer 0. 
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15. Pilih menu Select > Load Selection. 
16. Di bagian Channel, 

pilih Blue Copy. 
17. Tekan tombol OK 

sehingga muncul bidang 
seleksi di area langit. 

18. Tekan tombol Shift + 
Ctrl + I untuk membalik 
seleksi. 

 
 

 
19. Klik ikon Add 

Layer Mask ….. 
yang ada di dalam 
panel Layers bagian 
bawah. 

20. Objek langit di 
sembunyikan oleh 
Layer Mask seperti 
tampak pada gambar 
di bawah ini. 

21. Pilih menu layer 
>  

22. New > Layer. 
 

23.  Klik dan drag Layer 
1 itu ke bawah Layer 0 
sehingga susunan 
kedua layer itu menjadi 
terbalik. 

24. Pilih Paint Bucket 
Tool. 
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25. Klik ikon warna latar depan dan pilih warna biru tua (#000cff). 
26. Tekan tombol OK dan warna latar akan menjadi biru. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Inilah Hasil akhirnya 
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Menyatukan teks Gaya dan “ plastic Wrap” 
Kita akan menciptakan efek baru dengan memadukan dua efek teks 
yang sudah kita buat. Efek seperti apa yang akan tampak didalam teks 
itu ? 
 
Berikut langkah- langkah penyatuannya :  
1. munculkan panel  Layers terlebih dahulu . 
2. Kemudian, klik Blending Mode dan pilih beberapa alternatif 

berikut :  
 Screen . 
 Linear Dodge 
 Hard Light. 

 
Quick Selection Tool 

Dan smart filters 
 
Photoshop Cs3 memiliki tool baru yang bernama quick selection Tool. 
tool ini diletakan bersama-sama dengan Magic Wand Tool yang sudah 
sejak lama hanya sendirian. Kita akan menggunakan Quick selection 
Tool untuk menyeleksi objek secara mudah dan rapi tanpa harus 
menggunakan metode lama yang biasa ditempuh oleh para profesional. 
 
Seleksi menggunakan quick selection Tool 
  
Pertama-tama kita akan menyeleksi objek utama menggunakan quick 
selection Tool. setelah objek utama terseleksi, kita akan melakukan 
aksia-aksi tambahan ,seperti memberinya efek khusus atau lainnya . 
 
Berikut caranya menyeleksi objek utama menggunakan quick selection 
Tool : 
1. Buka file  “bunga.jpg”yang ada didalam CD sehingga anda akan 

melihat tampilan foto dibawah ini : 
2. Pilihlah quick selection Tool dari dalam toolbox . 
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3. Untuk Brush  ,pilihlah ukuran kuas sebesar 30 px . 
4. arahkan kursor mouse disalah satu kelompok bunga . 
5. Tekan tombol kiri mouse bsebanyak satu kali saja dan area sekitar 

akan langsung terseleksi . 
6. Beralihlah kekelompok bunga yang lain . 
7. Klik tombol kiri mouse sekali seperti yang sudah kita lakukan 

sebelumnya sehingga area itu akan langsung terseleksi . 
8. Lakukan berulang –ulangdengan hanya mengklik pada area 

kelompok bunga sampai seluruh kelopak bunga terseleksi . 
9. pilih menu filter> confert for smart filters. 
10. Tekan tombol OK jika anda menemukan kotak dialog seperti 

Gambarv 11,9. 
11. Lanjutkan dengan mengklik menu Filter >Blur> Lens Blur. 
12. setelah jendela Lens Blur muncul ,klik kotak cek invert agar latar 

belakang bunga tampak kabur . 
13. Setelah itu ,atur tingkat kekaburan latar belakang dengan mengatur 

slider Radius (sesuaikan dengan selera anda ). 
14. Tekan tombol OK 
15. Amati tampilan yang terlihat didalam panel layers .disana anda bisa 

mengedit ulang tingkat kekaburan Lens Blur dnegan mengklik 
ganda tulisan  “Lens Blur”. 

 

 
Menajamkan tekstur  

Dan menciptakan efek cahaya 
 

bagaimana menajamkan tekstur sekaligus menciptakan efek cahaya 
pada sebuah foto ?Biasanya ,kita menempuh dua kali jalan untuk 
mengerjakan dua tugas tersebut .tapi banyak kalangan tidak menyadari 
bahwa menajamkan tekstur dan menciptakan efek cahaya bisa 
dilakukan dalam satu kali jalan saja . 
Menngunakan Lighting efects 
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Filter yang akan kita pakai Lighting efects. secara umum filter ini 
berfungsi untuk menciptakan efek cahaya tapi dengan modifikasi 
sedikit, kita bisa menciptakan efek –efek tambahan yang menarik . 
 
Berikut langkah-langkah lighting Efects tersebut: 
1 Terlebih dahulu ,buka file image yang akan diberikan efek 

lighting Efect 
2 Pilih menu Filter >Render > Lighting Efects. 
3 Setelah anda berada di dalam jendela Lighting efects ,atur arah 

cahaya dari kanan kekiri .setting lain untuk cahaya gunakan 
seperti spesifikasi Gambar 12.4. 

4 Klik Bagian teksture Channel 
5 Pilihah Red 
6 Tekan tombol oK dan anda akan melihat efek lukisan seperti 

gambar dibawah ini  
7 Pilih menu edit >Fade lighting Efects . 
8 Turunkan nilai Opacity kira-kira sampai pada posisi 37% 
9 Kemudian klik bagian mode dan pilihlah lighten . 
10 Tekan tombol OK. 
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